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    واحد کار
اول



اهداف رفتاری:
پس از آموزش این واحد کار از فراگیر انتظار می رود:

1. امکانات سیستم عامل ویندوز را شرح دهد.

2. ویندوز را تعریف کند.

3. پنجره و اجزای آن را نام ببرد.

4. مفهوم Icon  را شرح دهد.

5. مدیریت File وFolder را انجام دهد.

6. روش جستجو File و........را انجام دهد.

Format .7 کردن یک درایو، حافظه و ........ را انجام دهد.

هدف کلی : به کارگیری کامپیوتر و مدیریت فایل ها

1. چگونه می توان وارد محیط کار ویندوز شد؟

2. اجزای اصلی کامپیوتر را نام برده و وظیفه هر کدام را شرح دهید؟

3. نحوه روشن و خاموش کردن کامپیوتر را توضیح دهید؟

پیش آزمون:)10 دقیقه(
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)operationfg system(تعریف سیستم عامل

مجموعه ای از برنامه ها که موجب راه اندازی و اســتفاده از کامپیوتر می شود"سیستم عامل"یا"os"گویند. سیستم 
عامل مهم ترین نرم افزار در کامپیوتر است.

پس از روشن کردن کامپیوتر اولین نرم افزاری که مشاهده می شود سیستم عامل بوده و آخرین نرم افزار قبل از
خاموش کردن نیز سیستم عامل است.

سیستم عامل نرم افزاریست که ارکان اجرای تمامی برنامه های کامپیوتری را فراهم می آورد.

وظایف سیستم عامل

سیستم عامل دو وظیفه )هدف( اصلی دارد:

1. سیستم عامل استفاده از کامپیوتر را ساده می سازد.

مثلا کاربر یا برنامه نویس بدون درگیر شــدن با مسائل سخت افزاری براحتی می تواند فایلی را به روی حافظه 
ذخیره و حذف کند.

2. سیســتم عامل باعث استفاده بهینه و سودمند از منابع کامپیوتر می گردد و آن ها را مدیریت می کند منظور 
از منابع، پرونده ها، حافظه ها، دیسک ها، موس، چاپگرها و غیره می باشد.

بطور کلی وظیفه سیستم عامل مدیریت اجزای کامپیوتر و سهولت استفاده از آن می باشد.

xp معرفی ویندوز -  

ویندوزxp یکی از سیستم عامل هایی می باشد که در سال 2001 توسط شرکت میکرو سافت در دو نسخه 1. 
منوی کار )میز کار( ویندوز کاملاً جذاب و ساده گردیده و منوی شروع به نحوکارآمدتری تنظیم شده است. 

2.چندین کاربر می توانند به صورت همزمان و مجزا از یکدیگر با یک سیستم عامل کار کنند.

3. نــرم افزارهای جانبی جدید نظیر DVD player ونرم افزار کپی،media player CD با ویژ گی های جدید 
اضافه شده است.
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4. قابلیت پشتیبانی از سیستم فایل NTFS برای افزایش امکانات امنیتی را دارد

5. نصب و ارتقاءِ و پشتیبانی ویندوز و سایر برنامه ها از طریق اینترنت آسانتر شده است 

  6. در تمامی پنجره های آن قسمتی بعنوان راهنمایی و کمک )help( به کاربر در نظر گرفته شده است.

)MOUSE(اصول کار با دکمه های ماوس -

ماوس وسیله ای است جانبی که برای کار در محیط های گرافیکی مثل ویندوز بسیار مفید و مؤثر است. ماوس با 
شکل های متفاوتی ظاهر می شود ولی عملکرد دکمه های آن یکسان و استاندارد است.

وقتی ماوس به کامپیوتر متصل است اشاره گر )Pointer(ماوس بر روی صفحه نمایش ظاهر می شود.

- برای آشنایی با دکمه های ماوس کارهای زیر را انجام می دهیم:

اشاره کردن :

موس را بر روی میز کار جابجا کرده و اشاره گر را بر روی شکلی قرار می دهیم.

Click:کلیک کردن

اگر بر روی عنصری که با موس به آن اشاره کردیم یک بار کلیک سمت چپ موس را فشار دهیم تا شکل مزبور 
انتخاب شود )Highlight( کلیک یا Select گویند.



12

Clickکلیک

یک بار فشردن و رها کردن دکمه سمت چپ موس را کلیک گویند.   

Double Clickدابل کلیک

دو بار فشردن متوالی و رها کردن دکمه سمت چپ ماوس را گویند.

)Rright Click(راست کلیک

با یک بار فشردن و رها کردن دکمه سمت راست بر روی شکل منوی خصوصیات               

 شکل نمایان می شود این عمل را راست کلیک گویند.

)Scroll(پیدایش

در صورتی که موس دارای دکمه وسط چرخشی باشد در هر پنجره باز اگر دکمه وسط را به  

 بالا و پایین بچرخانیم محتویات پنجره برای نمایش به بالا و پایین حرکت می کند.

)Drag &Drop( کشیدن و رها کردن

دکمه چپ موس را بر روی شکل دلخواه کلیک کرده و بدون رها کردن آن شکل مذکور را به محل دلخواه کشیده 
و رها می کنیم.



۱۳

)Desktop(میزکارویندوز-

میز کار ويندوز )Desktop( در حقیقت همان ناحیه کار اصلی ويندوز است که می توانیم در آن محیط برنامه های 
کاربردی خود را انجام نمايیم. پرونده های دلخواه خود را مشاهده و ويرايش نمايیم و فضای کار ويندوز را مطابق 

ذوق و سلیقه خود تنظیم کنیم. می توانیم بگويیم که:

تمامصفحهاصلیویندوزراکهبهعنوانناحیهکاریاستفادهمیشودمیزکارویندوزمیگویند.



۱4

)Icon(آیکن

تصاوير کوچک گرافیکی موجود در ويندوز را که معرف برنامه، پوش��ه و يا اس��ناد و مدارک باشد برای انتخاب هم 
زمان چند آيکون کافیست کلید Ctrlرا گرفته  و بر روی آيکون ها کلیک نمايیم.

)Folder(پوشه

محلی برای نگهداری فايل ها و برنامه ها می باشد که با نماد تصويری نشان داده می شود.                

Taskbarنوارکار

نوار افقی در پايین ترين نقطه میز کار است که شامل برنامه های در حال کار، منوی شروع و ساير ابزارهای مورد 
نیاز می باشد و دسترسی به برنامه ها و تنظیمات آن ها را آسان می نمايد.

Tray barسینیویندوز

قس��مت راس��ت نوار کار شامل اطلاعات و آيکن هايی از قبیل ساعت و زبان سیستم می باشد که به آن  سینی نوار 
ابزار ويندوز می گويند.



۱۵

)Menu(منو
لیس��تی از عناوين برنامه ها و دس��تورات قابل دسترسی در ويندوز است که گاهی هر برنامه شامل زير برنامه هايی 

نیز می باشند.

برای مشاهده منوی شروع بر روی  کلیک کرده تا پنجره آن ظاهر شود.

 - اشاره گر موس را بر روی دستورات آن حرکت می دهیم تا انتخاب شود.

 - برای اجرای يک دستور با موس بر روی آن کلیک می کنیم.

 - برای بستن لیست منوها بر روی ناحیه ای خالی از میز کار کلیک می کنیم.



۱6

Windowپنجره

هر برنامه کاربردی يا پوشه در قالب يک پنجره نمايان می شود کافیست بر روی پوشه يا برنامه کاربردی مورد نظر 
)مثلاmy computer( دابل کلیک کرده تا پنجره آن ظاهر شود.

)Title bar(نوارعنوان

نوار رنگی افقی بالاترين قسمت هر پنجره را که شامل نام برنامه يا پوشه حاوی آن می باشد را نوار عنوان گويند.

- ب��ه وس��یله موس ب��ر روی نوار عن��وان دابل کلی��ک می نمايیم پنج��ره به حداکث��ر اندازه ممک��ن تغییر پیدا 
می کند)maximize( اگر دوباره دابل کلیک نمايیم پنجره به اندازه قبلی تغییر می کند.

- با پايین نگه داش��تن کلید س��مت چپ موس بر روی نوار عنوان و جابجا کردن ماوس پنجره جابجا می ش��ود 
)Move(.
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)Menu bar( نوار منو

نوار افقی واقع در زیر نوار عنوان پنجره می باشــد که فرامین لازم برای کار با برنامه یا پوشــه در آن قرار دارد.

اگر در پنجره فایلی کلید ALT را به 
همراه حرفی که زیر آن خط کشــیده 
شده است بکار ببریم منوی مربوط باز 

خواهد شد.

ALT+V :  مثال

Toolbars نوار ابزار

نواری از دکمه های تصویری که در زیر نوار منو قرار دارد و برای دسترســی آسان به فرامین و امکانات هر پنجره 
بکار می رود.

)Address Bar( نوار آدرس

نوار آدرس کادر ســفید رنگی اســت که معمولا زیر نوار ابزار اکثر پنجره ها وجود دارد و درســت چپ آن کلمه 
Addres نوشــته شده است این نوار به ما این امکان را می دهد که آدرس برنامه ها پوشه ها و.... در آن تایپ کرده 

و فوری به آن دسترسی پیدا نماییم.
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)Folder( آشنایی با پوشه -

محلی برای نگهداری فایل ها و برنامه ها می باشد که با نماد تصویری نشان داده می شود به طور خلاصه در ویندوز 
مهم ترین مقررات نام گذاری پوشه ها به شرح زیر است.

* طول اسامی پوشه ها می توانند حداکثر 255 کاراکتر باشند.

* از کاراکترهای زیر نمی توان در نام گذاری فایل ها و پوشه ها استفاده کرد.

                          *|\/:ʺ><؟

* استفاده از حروف بزرگ و کوچک در نام گذاری مجاز است.

* بعضی از نام ها در  سیستم عامل رزرو شده و نمی توان آن ها را برای نام گذاری استفاده کرد.

CON-LPT1-LPT2-LPT3-NUL-PRN-COM1-COM2-COM3-COM4

Folder ایجاد پوشه -

برای ایجاد پوشه به ترتیب زیر عمل می نماییم:

- بر روی نقطه خالی از میز کار یا هر محل دلخواه دیگر راست کلیک می نماییم.

 - از منوی ظاهر شده گزینه New و سپس گزینه Folder را انتخاب می نماییم.
- پوشه ای جدید با پیش فرض New Folder ساخته می شود نام آن را به دلخواه تغییر می دهیم.
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-کپیوتغییرنامانتقالوحذفپوشه

* نمايشگر را بر روی پوشه مورد نظر برده و کلیک راست می نمايیم و دستور Copy را انتخاب می نمايیم.

* پوشه مورد نظر به حافظه موقت )CLIP BOARD( منتقل می شود.

* در محل مورد نظر )محل کپی پوشه(کلیک راست کرده و گزينه Paste را انتخاب می کنیم.

* پوشه به محل مورد نظر انتقال می شود.

* برای تغییر نام پوشه بر روی آن کلیک راست کرده و گزينه Rename را انتخاب می کنیم.

* نام پوشه آبی رنگ شده و می توان نام آن را تغییر داد.

* جهت انتقال فايل همانند روش Copy عمل کرده ولی به جای انتخاب Copy دستور CUT را انتخاب می نمايیم.

* جهت حذف پوش��ه بر روی آن کلیک راس��ت کرده و گزينه Delete را انتخاب می کنیم. در اين حالت پوشه 
مورد نظر موقتا به صندوقRecycle Bin می رود.

* اگر بخواهیم پوشه مورد نظر کاملا حذف شود کافیست در موقع حذف کلید  Shift را پايین نگه داريم.
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)File(مفهوموکاربردپرونده-

تمامی اطلاعات و برنامه های موجود در کامپیوتر صرف نظر از نوع يا محتوای آن ها در File نگهداری می شود. 
مثلا يک فايل می تواند شامل يک متن يا يک تصوير باشد.

فايل ها همانند پوش��ه ها و با همان قواعد دارای نام و پس��وندی دلخواه می باش��ند ولی پسوند فايل ها با توجه به 
ALi.EXE :محتوای آن ها تعیین می گردد و با يک نقطه از نام فايل جدا می شود. مثلًا

*پسوندهای EXE .bat،comمربوط به فايل های اجرايی می باشد.

*پسوندهای DOC،TXT مربوط به فايل های متنی می باشد.

*پسوندهای gif،Jpg،BMP مربوط به فايل های تصويری می باشد.

*پسوندهای bak،DWG مربوط به فايل های نرم افزار AUTOCADمی باشد.

پسوندهای RAR.ZIP مربوط به فايل های فشرده می باشد.

-انتقالکپیتغییرناموحذففایل

فايل ها را می توان همانند پوشه مديريت کرد بدين صورت که بر روی فايل کلیک راست کرده و از پنجره نمايان 
شده عملیات مورد نظر را انجام داد.
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Send toبادستورFileکپی-

برای اين منظور کافیست بر روی File راست کلیک کرده و از گزينه Send to انتقال مورد نیاز را انجام دهیم.

-جستجویفایلهاوپوشههاو.....

search گزينه Desktop  واقع در صفحه star برای جس��تجوی يک فايل يا پوش��ه کافیست از قس��مت منوی
را انتخاب نمايیم تا پنجره زير نمايان ش��ود در اين قس��مت می توان گزينه مورد نظر را انتخاب کرده و عملیات 

جستجو را انجام دهیم.
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Formatاصولفرمت-

هنگام��ی که بخواهیم محتويات درايو، فلاپی، فلاش را از بین ب��رده و مجدداً پیکربندی نمايیم عملیات فرمت را 
انج��ام می دهیم در اين حالت کافیس��ت بر روی حافظه مورد نظر کلیک راس��ت ک��رده و گزينه فرمت را انتخاب 

نمايیم.
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ا

۱. اجزای اصلی میز کار ويندوز را نام ببريد؟

۲. چند مورد از برنامه هايی را که از طريق دکمه start می توان به آن ها دسترسی پیدا کرد را نام ببريد.

۳. هدف از انجام عمل دابل کلیک روی آيکن برنامه ها چیست؟

4. برای جابجا کردن پنجره چه عملی را انجام می دهیم؟

۵. اجزای اصلی يک پنجره را توضیح دهید؟

6. يک پوشه با نام AUTOCAD در درايو D ايجاد کرد و يک فايل داخل آن کپی نمايید؟

7. پسوند های اجرايی در يک فايل را نام ببريد؟

8. يک فلاپی درايو يا يک Flash memory را با سیستم NTFS فرمت نمايید؟

۹. برای انتخاب چند آيکن پراکنده در میز کار و يا يک پنجره از ترکیب کدام دکمه ها استفاده می شود.

CTRL+Click)الف

CTRL+Rright Click)ب

SHIFT+Click)ج

SHIFT+RrightClick)د

۱0. کدام نوار امکان دسترسی سريع به برنامه و پوشه ها را فراهم می سازد؟

Toolbar)الف

Address bar)ب

Search bar)ج

Menu bar)د

ارزشیابیپایانی

-سئوالاتتشریحی

-سئوالاتچندگزینهای
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۱۱. در صورت کوچک بودن اندازه يک پنجره با چه ابزاری می توان کلیه محتويات درون آن پنجره 
را باز ديد کرد؟

Drag)الف

Scroll bar)ب

Address)ج

Mycomputer)د

۱۲.کدام يک از اسامی زير برای نام پوشه غیر مجاز است؟

Directory)الف

Photo*Baby)ب

ASP)ج

List.name)د

۱۳.محل قرار گرفتن يک فايل يا پوشه کپی شده در ...... می باشد.

الف(حافظه اصلی 

ب( هارد ديسکت

Clip board)ج

Rom)د

۱4.برای حذف دايمی فايل ها و پوشه ها از کدام گزينه استفاده می کنیم؟

Delete)الف

Recyclebin ب(کشیدن و انداختن در

Shift+Del)ج

CTRL+Del)د
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 ۱۵.کدام يک از اسامی زير را می توان برای نام گذاری نام فايل استفاده کرد؟

COM۱)الف

COM)ب

PORT)ج

NUL)د



    واحد کار
دوم



اهدافرفتاری:
پسازآموزشاینواحدکارازفراگیرانتظارمیرود:

- نرم افزار اتوکد را از طريق صفحه Desktop و منوی Start اجرا نمايد.
- اجزای محیط کاری نرم افزار اتوکد را بیان کند.

- اصول کار و روش های ورود فرمان های اتوکد را شرح دهد.
- تنظیمات محدوده ترسیم آن را انجام دهد.

- از موس و صفحه کلید جهت انتخاب منوها استفاده کند.

- روش های اجرای دستورات ذخیره سازی و فراخوانی فايل در اتوکد را انجام دهد.

هدفکلی:تواناییاجراینرمافزاراتوکدواجرایدستوراتمربوطبه

ذخیرهسازیوفراخوانیفایلهادراتوکد.

پیشآزمون:)10دقیقه(

۱. به چند طريق می توان يک نرم افزار را اجرا کرد؟
۲.کلیدهای موس چه وظايفی را بر عهده دارند؟

۳. منظور از نوار عنوان در پنجره نرم افزارها چیست؟
4. محدوده های ترسیم استاندارد را نام برده و ابعاد آن را طبق اصول نقشه کشی بنويسید؟

۵. نحوه بستن يک نرم افزار به چه صورت است؟
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AUTOCADراهاندازیواجراینرمافزار-

* انتخاب آيکن نرم افزار که بر روی صفحه Desktop قرار دارد                       

و دابل کلیک بر روی آن

* بر روی آيکن فوق کلیک راست کرده و گزينه Open را انتخاب می نمايیم

 AUTOCAD ش��ده و طبق ش��کل زير بر روی  فايل اجرايی All program وارد قس��مت Start از منوی *
کلیک می کنیم.
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AUTOCADآشناییبامحیطنرمافزار-

پس از ورود به محیط اتوکد پنجره زير را در اختیار داريم.

DRAWING AREAصفحهترسیمی-

صفحه سیاه رنگ موجود در پنجره اتوکد صفحه ترسیمی می باشد که در اين صفحه نماد     

مع��رف  محور مختصات y،x و صفحه کاری دو بعدی می باش��د و  مکان نم��ا )Cursor(به منظور ابزار طراحی و 
نقشه کشی وجود دارد.

)دقتنماییدپنجرهنمایشدادهشدهمربوطبهفضایکاریAUTOCAD CLASSICمیباشد.(
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MENU BARنوارمنو

نوار منو يا نوار کرکره ای در قسمت بالای پنجره AUTOCAD می باشد که شامل فرمان های اتوکد می باشند که 
هر کدام شامل زير مجموعه هايی از دستورات مديريتی، ترسیمی، ويرايشی و .... می باشند 

به منظور استفاده از نوار منو روی مورد نظر رفته و کلیک می نمايیم.

Tool barنوارابزار

دس��تورات و فرمان ه��ای نرم افزار CAD به ص��ورت تصويری در نوارهايی قرار دارند که هر نش��انه دارای تصوير 
خاصی است که معمولا بیانگر نوع عملکرد و دستور می باشد برای اجرای هر دستور کافیست بر روی تصوير دستور 

مورد نظر کلیک نمايیم.
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-نوارابزارهایموردنیاز

برخی از نوار ابزارهای لازم برای ترسیم به صورت زير می باشند:
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-فعالکردنیکنوارابزار

* برای فعال کردن يک نوار ابزار مورد نیاز کافیست بر روی يک آيکن کلیک راست کرده و از پنجره ظاهر شده 
نوار ابزار مورد نیاز را انتخاب نمايیم.

ACAD اگ��ر در فضای خال��ی نوار منو )منوی کرکره ای(مقابل يک نوار ابزار کلیک راس��ت نمايیم از ش��اخه *
می توانیم نوار ابزار مورد نیاز را فعال کنیم.

COMMANDخطفرمان-

يکی از قس��مت های مهم در نرم افزار قس��مت خط فرمان اس��ت در اين نواحی می توان دس��تورات و يا مخفف 
دستورات را به طور مستقیم تايپ نمود.

                              Command:Line         اجرای دستورخط

Command:L              مخفف دستور خط
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Status barنواروضعیت-

مطابق ش��کل بالا نوار وضعیت در زير خط فرمان قرار دارد که ش��امل نمايش مختصات مکان نما )Cuorsor( و 
کلیدهايی برای فعال و غیرفعال کردن برخی فرمان ها و تنظیمات آن ها است.

-برای غیر فعال شدن محل نمايش مختصات مکان نما کافیست بر روی آن کلیک نمايیم 

-کلیدهای سريع قسمت Status bar بشرح زير است.
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-روشهایورودفرمانهایاتوکد

* استفاده از نوار منو )menu bar(:کافیست دستور مورد نیاز را در منوی مربوطه پیدا کرده و اجرا نمايیم برای 
اين منظور موس را بر روی منوی مربوطه برده و دستور را انتخاب می کنیم.

* اس��تفاده از نوار ابزار )Tool bar(:در اين روش کافیس��ت تصوير دستور مورد نظر را شناخته و با کلیک بر روی 
آن دستور را اجرا نمايیم.

* اس��تفاده از خط فرمان)Command bar(: دس��تور مورد نیاز را به طور کامل يا به طور خلاصه در اين قسمت 
type می نمايیم و کلید ENTER را می زنیم.
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اگر در صفحه ترسیم راست کلیک نمايیم منويی باز می شود که به آن منوی میان بر )Short cut menu(گويند 
و از طريق آن می توان آخرين فرمان اجرا شده با برخی فرمان های پر کار ديگر را انتخاب و اجرا کرد.

- بع��د از تاي��پ فرمان در خط فرمان برای اجرای آن کافیس��ت کلید  EnterياSpace bar يا راس��ت کلیک 
نمايیم.

- اگر در قسمت خط فرمانEnter نمايیم آخرين فرمان اجرا شده قبلی مجدد اجرا می شود.

- ب��ا کلیدهای بالا و پايین )واقع در صفحه کلید( می توان دس��توراتی را که قب��لا اجرا نموديم پیدا کرده و در 
صورت لزوم آن را استفاده و اجرا کنیم.

- از مخفف دس��تورات نیز می توان جهت اجرای يک دس��تور اس��تفاده کرد مثلا بجای Line حرف L را تايپ 
نمايیم. اين خلاصه دستورات را در فايلی بنام ACAD.PGP می توان تعريف کرد.

محدودهترسیموتنظیماتآن:

بطور معمول در ترسیمات نقشه ابعاد کاغذ جهت ترسیم را مطابق با ابعاد نقشه تهیه کرده و در نظر می گیرند 
مثلا کاغذ های A3،A4و.....

نکات:
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در نرم افزار AUTOCAD در ابتدا بايس��تی محدوده ترس��یم )صفحه س��یاهرنگ ( را وارد کرده يعنی طول و 
عرض صفحه ای را که می خواهیم در آن ترسیم را انجام دهیم تعیین نمايیم برای اين منظور دستورLimits را 

در خط فرمان تايپ می نمايیم و به ترتیب شکل عمل می نمايیم.

Command:Limits    اجرای دستور

 Specify Lower Left Corner>0مختصات گوشه سمت چپ و پايین صفحه >0و

Specify  Upper Rright Corner>۱۲مختصات گوشه سمت راست و بالای صفحه>۹و

- به عنوان مثال اگر بخواهیم محدوده ترسیم ها  A۳ افقی باشد کافیست:

در گوشه سمت چپ و پايین )Lower Left Corner( مختصات 0و0 وارد کرده و در گوشه راست و بالای 
صفحه)Upper Rright Corner( مختصات ۲۹7 و 4۲0 وارد نمايیم. 
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توجه

بعد از تنظیم محدوده ترس��یم به کمک دس��تور Limits  کافیس��ت در قسمت خط فرمان دستورات زير را انجام 
نمايیم.

COMMAND:Z   A  

روشانتخابمنوهاودستورات:

ALT اجرایدستورازطریقنوارمنو: اين روش در واحد کار توضیح داده شده است بدين ترتیب که کلید-
           و  را گرفته و کلمه ای که زير آن خط کش��یده ش��ده را می زنیم بعد از باز ش��دن منوی مربوطه با کلید های

صفحه کلید دستور مورد نظر را انتخاب می نمايیم.

- بوس��یله م��وس روی منوی مورد نظ��ر رفته و با کلیک کردن بر روی آن منو را باز کرده و دس��تور را انتخاب و 
کلیک می نمايیم.

کلیدهایموس:

کلید سمت چپ= انتخاب موضوع يا کلیک

کلید سمت راست= اينتر )همچنین کلید Spacebar نیز همین عمل را انجام می دهد(

نگه داشتن کلید وسط و حرکت دادن موس =Panجابجايی ترسیم

چرخاندن کلید وسط=Zoom  بزرگنمايی ترسیم
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-فراخوانیوذخیرهسازی

Save.Save AS ذخیره سازی *

برای ذخیره س��ازی يک ترس��یم کافیس��ت از منوی File و ي��ا از منوی تصويری گزين��هSave را انتخاب نمايیم 
هنگامیکه برای اولین بار اين دستور اجرا می شود پنجره زير نمايان می شود 

توجه:
- اگر بخواهیم ترس��یم را با نامی متفاوت ذخیره نمايیم از منوی File گزينه Save as را انتخاب می نمايیم در 

اين حالت پنجره فوق نمايان می شود می توانیم در قسمت نام فايل نام جديد را وارد نمايیم.

-از کلید های ترکیبی Ctrl+S نیز می توان برای ذخیره سازی استفاده کرد.

Drawing .Dwg می باشد مثلا Dwg پسوند فايل های ترسیمی -

- فايل های ترسیمی CADبا پسوندهای زير نیز ذخیره می شوند.

*Dxfفايل هايی که قابل باز شدن در ساير نرم افزارهای گرافیکی می باشند.

Dwtفايل هايی که به عنوان پیش فرض TemPlateجهت شروع ترسیم استفاده می شود.
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Quite پنجره ترسیم را ببنديمclose  را انجام دهید با زدن Save اگر در اتمام ترسیم بدون اينکه عمل -
را در خط فرمان تايپ نمايیم پنجره زير نمايان می شود.که می توانیم با انتخاب:

-گزينه Yesعمل ذخیره سازی يا Save را انجام دهیم.

-گزينه NO از ذخیره سازی و يا اعمال تغییرات منصرف شويم.

-گزينه Cancel از پنجره باز شده را ببنديم.
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نما و......و نماد......است. ۱. در صفحه ترسیمی اتوکد 

۲. اگر در صفحه ترسیمی کلیک راست نمايیم منويی باز می شود که به آن .....گويند.

۳. مراحل اجرای نرم افزار اتوکد را بنويسید.

4. روش تنظیم محدوده ترسیم را شرح دهید؟

۵. روش فعال کردن يک نوار ابزار را توضیح دهید؟

6. يک دستور را از چه روش هايی می توان اجرا کرد؟

7.کلیدهای عملکرد سريع دستورات Startus bar را بنويسید؟

ارزشیابیپایانی)در زمان ۱۵ دقیقه(

نظری

۱. نرم افزار اتوکد را اجرا نمايید.

۲. محدوده ترسیم مطابق با يک کاغذ A۲ را برای نرم افزار تعريف کنید.

۳. نواره��ای اب��زار Text .Zoom،Layers،Dimension، Modify.Drawرا فعال کرده و اطراف 
صفحه ترسیمی قرار دهید

4. يک فايل با نام ACAD.DWT باز نمايید

۵. فايل باز شده را با نام CNC ذخیره نمايید.

6. از نرم افزار خارج شويد.

ارزشیابیپایانی)در زمان 4۵ دقیقه(

عملی



    واحد کار
سوم



4۲

اهدافرفتاری:

پسازآموزشاینواحدکارازفراگیرانتظارمیرود:

۱. سیستم مختصات را تعريف نمايد.

۲. دستگاه مختصات کارتزين و قطبی تعريف کند.

۳. مختصات نقاط يک نقشه ترسیمی را به صورت مطلق نسبی و قطبی استخراج نمايد.

4. روش های وارد کردن مختصات بصوت مطلق نسبی و قطبی را در نرم افزار اتوکد شرح دهد. 

هدفکلی:شناختروشهایمختصاتی

پیشآزمون:)20دقیقه(

۱.منظور از مختصات z،y،x جهت مشخص کردن يک نقطه چیست؟

۲.ي��ک مربع ب��ا ابعاد 80×۱00 در صفحه ترس��یم نمايد بطوريکه مح��ور مختصات در مرکز آن 
باشد.

۳.يک نقطه با مشخصات )80و۵0( را در صفحه مشخص نمايد.



4۳

سیستممختصات

در ترسیمات هندسی و رياضیات به منظور ترسیم اشکال مختلف از قبیل نقطه، خط، منحنی، صفحه و حجم به 
سیستم مختصات نیاز داريم.

فاصله هر طولی و عرضی نقطه روی ترسیم نسبت به يک مرجع سنجیده می شود که به آن مرکز محور مختصات 
می گويند.

-سیستممختصاتکارتزین

برای تعريف مختصات در يک صفحه به دو مولفه x،y و در فضا به سه مولفه x،y،z نیاز داريم.

مولفه x بیانگر فاصله طولی )افقی(نسبت به نقطه مرجع )مبنا( می باشد.

مولفه x بیانگر فاصله عرضی )عمودی( نسبت به نقطه مرجع )مبنا( می باشد.

- مثلا مختصات يک نقطه در صفحه که فاصله آن از محور x ،۳0 میلی متر و از محور y ،40 میلی متر اس��ت به 
صورت )40وp)۳0 نمايش داده می شود.

40

۳0

y

p

x

در صورتیکه فاصله همین نقطه از محور z ،۵0 میلی باش��د مختصات نقطه به صورت )P)۳0,40,۵0نمايش داده 
می شود z=۵0 ، y=40،x=۳0 ، بدين معنا است که نقطه از صفحه ترسیمی ۵0 میلی متر بالاتر است.

     

 

    

z

40

۳0

y p

x

۵0
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                       نکته

بر اساس استاندارد در ماشین های افزار محور Z در امتداد محور اصلی ماشین )اسپیندل( و محورهای x،y بر 
روی میز ماشین فرض گرديده اند.

                        

40

۱00

y

Ax

x

x=0

y=0

)0،0(

مثال: مخصات نقطه)Aَ)َ۱00,۵0 را ترسیم نمايید.              

۱.ف��رض می کنی��م می خواهی��م از مرج��ع محور 
مختص��ات به صورت افقی و روی محورx  به اندازه 

۱00 میلی متر جلو برويم.تا به نقطه AX برسیم.                                         

                            

۵0

A

x
x=0

y=0

۱00
)0،0(

                   
Y ۲. از اي��ن نقط��ه بطور عمودی و م��وازی محور
 A ب��ه اندازه ۵0 میل��ی متر بالا رفته ت��ا به نقطه

برسیم.            

 

                                    

-مختصاتمطلقونسبی

در سیستم مختصات کارتزين يک نقطه به دو صورت تعريف می شود. 

1.مختصاتمطلق:

در اين سیستم موقعیت تمام نقاط يک ترسیم نسبت به مرجع و مبداء مختصات سنجیده می شود.

در اين حالت مختصات نقاط P۱تاP4 به صورت زير است:

P۱)۱0,۲0(
y

                                                                   P۲)۱00,۲0(

P۳)۱00,۵0(

P4)۱0,۵0(

x



4۵

-مختصاتنسبی

در اين سیس��تم موقعیت هر نقطه نس��بت به نقطه قبلی خودش س��نجیده می ش��ود.يعنی برای بدس��ت آوردن 
مختصات هر نقطه محور مختصات را در نقطه قبلی قرار داده و نقطه جديد را نسبت به آن می سنجیم.

مختصات نقطه P۱  نسبت به مبدا مختصات )۱0,۲0(P۱ )يعنی از مبدا مختصات می خواهیم به نقطه P۱ حرکت کنیم.

مختصات P۲نسبت به ۹0,0(P۱(P۲)يعنی از نقطه P۱می خواهیم به نقطه P۲حرکت کنیم.

   

y

x

y

x
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مختصات P۳  نسبت بهP۳)0,۵0( :P۲ يعنی از نقطه P۲ می خواهیم به نقطه P۳حرکت کنیم.

مختصات P4نسبت به P4)-۹0,0( :P۳يعنی از نقطه P۳ به نقطه P4حرکت کنیم.
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AUTOCADمختصاتمطلقونسبیدرنرمافزار-

برای وارد کردن مختصات به صورت مطلق در نرم افزار CAD کافیس��ت ابتدا يک دس��تور ترسیمی اجرا نمايیم 
در قسمت خط فرمان )COMMAND( اگر جملات:

 Specify First Point نقطه اول را مشخص نمايید -

Specify LAST Point نقطه آخر را مشخص نمايید -

Specify NEXT Point نقطه بعدی را مشخص نمايید -

 Specify CENTER Point نقطه مرکز را مشخص  نمايید -

ظاهر گرديد بدين معنی است که بايستی مختصات يک نقطه را وارد نمايیم

در صورتی که مختصات نقطه را به صورت دو عدد که بین آن ها ويرگول قرار د ارد وارد نمايیم مختصات به صورت 
مطلق در نظر گرفته می شود

و اگر قبل از وارد کردن مختصات نماد نسبی  )Shlft +۲( @ را بنويسیم مختصات نقطه به نقطه قبلی درج شده 
و در نظر گرفته می شود
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اگر در نرم افزار Auto Cad در قسمت Statusbar بر روی DYN مخفف Dynamic input کلیک راست 
کرده و گزینه Settings را بزنیم پنجره مربوط به تنظیمات این قسمت نمایان می شود.

گزینه Enabel Dimension input where possible را فعال نماییم برای درج مختصات به صورت نسبی 
دیگر نیازی به وارد کردن نماد @ نمی باشد.
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- مختصات قطبی 

در سیســتم مختصات قطبی برای نشــان دادن موقعیت یک نقطــه واقع بر یک صفحه از دو پارامتر اســتفاده 
می شود.

- طول و یا فاصله نقطه تا نقطه قبلی

-  زاویه خط )و اصل نقطه تا نقطه قبلی( با زوایه صفر درجه

- قطبی مطلق

α فاصله نقطه p تا مبدا مختصات 

x زاویه بین این خط و محور  Ɵ

که از نقطه قبلی می گذرد.   

               
- قطبی نسبی

α فاصله نقطه P1  تاP2  به صورت نسبی

 زاویه خط P1P2   با خطی که به صورت افقی 

از P1  می گذرد.

مثال: مختصات نقاط داده شده را به صورت قطبی نسبی بنویسید.
p1=22/3>63ο  نسبت به مبداء مختصات

p1 نسبت به  P2=90>0ο

p2 نسبت به  P3=30>90ο

p3 نسبت به   P4=90>180ο

y

p

x

Ɵ

y p

x

Ɵ

α

P1
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Auto Cadنحوهاعمالمختصاتنقطهبهصورتقطبینسبیدر-

برای اين منظور کافیست در قسمت خط فرمان و زمانی که مختصات يک نقطه را از ما می خواهد به صورت شکل 
مختصات قطبی نسبی  را وارد نمايیم.

اگر مطابق ش��کل از قسمت Starusbar گزينه Setting را زده و ...  Enabel Dimension input را فعال 
نمايیم هنگام ترسیم کافیست با نمايشگر زاويه دلخواه را مشخص کرده و طول مورد نظر را وارد نمايیم.



۵۱

AUTO CADتعیینمختصاتیکنقطهدر

برای مشخص کردن مختصات يک نقطه به ترتیب زير عمل می نمايیم

۱. بر روی ترس��یم کلیک کرده تا انتخاب ش��ود و مربع های آبی رنگ بر روی آن ظاهر ش��ود. اين عمل باش��د 
.command هنگامی انجام می دهیم که در قسمت خط فرمان فقط کلمه نمايشگرCursur را بر روی مربع آبی 

رنگ قرار داده تا به رنگ سبز در آيد..

۳. در اين حالت مختصات نقطه در نوار مختصات مشخص می شود.



۵۲

۱. سیستم مختصات را تعريف کرده و مختصات کارتزين را شرح دهید.

۲. تفاوت تعیین موقعیت يک نقطه به صورت مطلق يا نسبی چیست؟

۳. در سیستم قطبی زاويه يک نقطه نسبت به چه مکانی تعیین می شود؟

عملی45دقیقه

۱. تنظیمات DYN را انجام دهید

۲. مختصات نقاط شکل های زير را به صورت مطلق و نسبی بنويسید.

نظری15دقیقه

ارزشیابیپایانی



    واحد کار

چهارم
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تواناییها:
۱. توانايی اجرای دستورات ترسیمی و ويرايشی

Line -Circle-Erase-Trim-Ortho-Rectangle-Undo-Redo-Units

۲. توانايی اجرای دستورات ترسیمی و ويرايشی
Arc-Osnap-Copy-Move-Fillet-Chamfer-List

۳. توانايی اجرای دستورات ترسیمی و ويرايشی 
Rotate-Scale-Array-Mirror-Offset-Hatch

هدفکلی:اجرایفرمانهایترسیمیویرایشیو
AUTOCADکمکترسیمیتواناییهانرمافزار

اهدافرفتاریتوانایی1:

پسازآموزشاینواحدکارازفراگیرانتظارمیرود:

۱. ترسیم خط و دايره را به روش های مختلف در اتوکدتوانايی ترسیم کند.

۲. روش های پاک کردن موضوعات با استفاده از دستوراتErase,trim را انجام دهد.        

۳. خطوط افقی و عمودی را ترسیم کند.

۵. مستطیل را به روش های مختلف ترسیم کند.

6. يک شکل هندسی شامل خط و دايره را ترسیم کند.

هدفکلی:تواناییاجرایدستوراتترسیمیوویرایشی



۵۵

۱. به چه طريق می توان مختصات يک نقطه را به صورت مطلق نسبی و قطبی در نرم افزار وارد کرد؟

۲. علامت مختصات قطبی يک نقطه چیست؟

۳. برای )cancle(کردن يک دستور از چه کلیدی در keyboard می توان استفاده کرد؟

4. کدام کلید برای پاک کردن در صفحه keyboard استفاده می شود؟

۵. برای ترسیم يک پاره خط چه مشخصاتی لازم است؟

6. اگر نقاط C،B،A مطابق شکل قرار داشته باشند مطلوبست:

الف: مختصات نقطه B نسبت به نقطه A به صورت مطلق 

ب: مختصات نقطه B نسبت به نقطه C به صورت نسبی

ج: مختصات نقطه C نسبت به نقطه A به صورت قطبی 

 

پیشآزمون

C

A

B

40

100
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دستورکار1
قبل از آموزش لازم است معانی و کاربرد لغات و اصطلاحات زير فرا گرفته شود،

LINE     خط                                                                            

CIRCLE   دايره                                                                      

RECTANGLE مستطیل                                                     

ERASE  پاک کردن                                                               

TRIM  برش موضعی                                                           

ORTHO افقی و عمودی کردن مکان نما                                  

UNDO خنثی کردن دستور                                                    

REDO                                                                 undo معکوس

UNITS   واحدها                                                                  

COMMAND خط فرمان                                                  

SPECIFY                                                    مشخص کردن

FIRST POINT                                                 اولین نقطه 

NEXT POINT نقطه بعدی                                               

SECOND POINT                                            نقطه دوم

CORNER   گوشه                                                               

OTHER ديگری                                                                

CENTER   مرکز                                                                 

RADIUS شعاع                                                                  

DIAMETER قطر                                                            

CLOSE          بستن                                                                    

DRAW   ترسیمی                                                                   

MODIFY اصلاح کردن                                                         



۵7

lineفرمان
از اين دستور برای ترسیم يک پاره خط به صورت های مختلف استفاده می شود.

را از سه طريق می توان اجرا کرد

Menubar: draw<line

Toolbar: draw<line

Command : line  يا L   

همانطور که می دانید برای ترسیم يک پاره خط مشخص کردن نقطه ابتدا و انتهای آن لازم است بنابراين می توان 
برای ترسیم يک پاره خط نقاط ابتدا و انتها را به دو صورت زير وارد کرد.

۱.تايپ مختصات ابتدا و انتها در خط فرمان 



۵8

۲. انتخاب دو نقطه با استفاده از نمايشگر موس

در صورتی که بخواهیم مختصات دو نقطه را به وسیله نمايشگر موس به صورت مطلق مشخص نمايیم لازم است 
تنظیمات مطابق شکل را در قسمت DYN انجام دهیم

                         نکته:
برای فعال و غیر فعال کردن DYN از کلید F۱۲ صفحه کلید می توان استفاده کرد

در اين حالت کافیست نمايشگر را در صفحه ترسیمی حرکت داده تا مختصات مورد نظر ظاهر شود.

و ب��ا کلیک کردن اين نقطه به عنوان اولین نقطه انتخاب می ش��ود نقاط بع��دی را نیز می توانیم به همین ترتیب 
انتخاب نموده و ترسیم را انجام دهیم.



۵۹

                  

                            نکات:
۱. فرمان line برای ادامه محدوديتی ندارد و می توان به تعداد دلخواه پاره خط ترسیم کرد.

۲. با وارد کردن گزينهUndo آخرين نقطه انتخاب شده لغو می شود.

ORTHOدستور-

به وسیله اين دستور می توان حرکت نمايشگر را در حالت های افقی و عمودی محدود کرد.

ORTHO  نحوه فعال کردن

۱. ازقسمت Status bar بر رویORTHO کلیک نمايیم 

۲. کلید F8 )بر روی keyboard( را بزنیم

                        نکته:
کلید ORTHO فقط هنگامی عمل می کند که يک دستور ترسیمی مثلا line اجرا شده باشد.
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UNITSفرمان

از اين دستور برای تنظیم واحدهای طولی و زوايا استفاده می شود 

برای اجرای فرمان بر دو روش عمل می نمايیم تا جدول تنظیمات UNITS ظاهر شود  

MENU BAR : FORMAT<UNITS

COMMAND : UNITS

تنظیمات UNITS در تمامی قسمت های زير تاثیر می گذارد.

 ۱. نمايش مختصات مکان نما

DYN ۲.نمايش موقعیت در هنگام ترسیم و فعال بودن

.LISTو  DIST ۳. در هنگام استفاده از دستورات

              

     



6۱

دستورکار1

۱. ترسیم يک مربع با ابعاد ۵0 ×۱00 به ۵  روش های زير :

استفاده از مختصات گوشه های شکل به صورت مطلق: دستور line را اجرا کرد و در قسمت خط فرمان 
)command( به ترتیب مختصات نقاط P4، P۳، P۲ ،P۱ را وارد می نمايیم تا شکل ترسیم شود.

توجه:
در حالت ترسیم کلید DYN غیر فعال باشد.

نکته:
بعد از وارد کردن نقطه P۳ کافیست حرف C در خط فرمان را تايپ کرده تا شکل کامل گردد.

نکته:  

بعد از وارد کردن هر مختصات کلید ENTER را می زنیم.

نکته:
استفاده ازu )مخفف undo( به جای مختصات در جلوی فرمان  

Specify next point or ]undo[

باعث لغو مختصات داده شده  قبلی می شود و می توان مختصات جديدی را وارد کرد
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۲. استفاده از مختصات گوشه های شکل به صورت نسبی:  
نقطه P۱ نسبت به مبدا مختصات  

  P۱ نسبت به نقطه P۲ نقطه
 P۲ نسبت به نقطه P۳ نقطه
P۳ نسبت به نقطه P4 نقطه

و در نهايت از گزينه Close برای رسم خط
 از P4 به P۱ استفاده می کنیم.

بعد از اجرای دستور LINE مختصات را به صورت نسبی)با قرار دادن علامت @ قبل از مختصات( وارد می نمايیم.               

نکته:   

مختصات نقطه اول را به صورت مطلق وارد می نمايیم. 

۳. استفاده از مختصات شکل به صورت قطبی نسبی :    

نقطه P۱ به صورت مطلق 

نقطه P۲ نسبت به P۱  به طول ۹0 و زاويه صفر

نقطه P۳ نسبت به P۲  به طول ۳0 و زاويه ۹0

نقطه P4 نسبت به  P۳ به طول ۹0 و زاويه ۱80  

 P۱ به P4 برای رسم از  close و در نهايت از گزينه

استفاده می کنیم.

                      

                          نکته:
اگر طول و زاويه نقطه P۱ نسبت به نقطه قبلی را نداشتیم مختصات آن را به صورت مطلق وارد می نمايیم.
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بعد از اجرای دستور LINE مختصات را به صورت قطبی نسبی وارد می نمايیم. 

زاويه خط نسبت به نقطه قبل < طول خط با علامت مثبت@

4. با استفاده از طول پاره خط و فرمان ORTHO کلید F8 را می زنیم تا فرمان ortho  فعال شود و حرکت مکان 
نما محدود حرکت افقی و عمودی گردد.

- دستور LINE را اجرا کرده و مختصات اولین نقطه را به صورت مطلق وارد می نمايیم.

- مکان نما در حالت افقی به سمت راست قرار داده و مقدار ۹0طول پاره خط P۱ P۲  را وارد می کنیم.

- مکان نما در حالت عمودی و رو به بالا قرار داده و مقدار ۳0 طول پاره خط P۲ P۳  را وارد می کنیم.

- مکان نما در حالت افقی و سمت چپ قرار داده و مقدار ۹0طول پاره خط P۳ P4  را وارد می کنیم.

- حرف c مخفف close را زده تا شکل کامل شود.

DYN ۵. با استفاده از مختصات شکل و فرمان

تنظیم��ات DYN  را همانطور که قبلا توضیح داده ش��ده انجام می دهی��م و با کلید F۱۲ آن را فعال می کنیم و 
دستور LINE را اجرا می کنیم.

توجه: فرمان  ORTHO  را غیر فعال کنید. 

 Precision نمايش اعداد به صورت بدون اعشار باشد يعنی قسمت UNITS توجه:در تنظیمات
بر روی صفر باشد.
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برای ترسیم شکل کافیست بوسیله موس به مختصات نقاط P۱  رفته و کلیک نمايیم به همین ترتیب ساير نقاط 
را پیدا کرده و کلیک می نمايیم.                                                                  

                         نکته:
برای کامل شدن شکل بعد از انتخاب نقطه P4 حرف C  را تايپ کرده و ENTER می نمايیم.

ERASEفرمان

از اين فرمان جهت پاک کردن يک ترسیم استفاده می شود 

اجرایفرمان
Menubar:Modify> Erase
Toolbar : Modify> Erase

Command: Erase یا E

بعد از اجرای دستور موضوعات مورد نظر را انتخاب کرده و کلید ENTER را می زنیم.
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نکته:  

ب��رای پ��اک کردن موضوعات ترس��یمی می توان ابتد آن ها را انتخاب کرد تا Highlight ش��وند و س��پس کلید 
DELETE روی KEY BOARD را می زنیم.

CIRCLEفرمان

اجرای فرمان

Menubar : Draw> Circle>...

Toolbar : Draw> Circle

Command :  Circle یا c

بعد از اجرای فرمان از نوار ابزار DRAW يا تايپ آن در خط فرمان لازم است ابتدا مختصات مرکز و سپس شعاع 
دايره را وارد نمايیم.

 نکته:
اگر بخواهیم دايره را با اندازه قطر رسم نمايیم کافیست در قسمت

Specify radius of circle or ]Diameter[: D 

حرف D را تايپ کرده تا جمله زير ظاهر شود و در اين قسمت می توانیم مقدار قطر را وارد نمايیم.
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Specify Diameter of circle

روش های ديگر ترسیم دايره-
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CENTER-RADIUS ۱.رسم دايره به کمک مرکز و شعاع

- انتخاب مرکز دايره 

- وارد کردن مقدار شعاع  

 

CENTER-DIAMETER۲.رسم دايره به کمک مرکز و قطر

- انتخاب مرکز دايره

- وارد کردن قطر دايره

۲POINT ۳.رسم دايره به کمک دو نقطه

- انتخاب دو نقطه

۳POINT 4.رسم دايره به کمک سه نقطه

- انتخاب سه نقطه
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TAN.TAN.RADIUS.۵. رسم دايره مماس بر دو شکل و شعاع دايره

- انتخاب دو شکل

- وارد کردن شعاع دايره

TAN.TAN.TAN 6. رسم دايره مماس بر سه شکل

- انتخاب سه شکل

یادآوری

جهت وارد کردن يک نقطه مثلا مرکز دايره به ۳ روش می توان عمل کرد:

۱. بوسیله مکان نما بر روی صفحه ترسیمی کلیک نمايیم.

 ۲. مختصات نقاط را به روش مطلق و يا نسبی در خط فرمان تايپ نمايیم.
۳. از DYN کمک گرفته و بوسیله موس مختصات نقطه را بطور دقیق تنظیم کرده و کلیک نمايیم.

RECTANGLEدستورمستطیل
 از اين دستور جهت ترسیم يک چهارضلعی استفاده می شود.

Menubar: Draw> Rectangle

Toolbar : Draw> Rectangle

Command :  Rectangle یا Rec

برای ترسیم چهار ضلعی مختصات دو نقطه لازم است.
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بعداز اجرای دستور مختصات دو نقطه خواسته شده را وارد می نمايیم برای اين منظور می توانیم در خط زمان 
مختصات را تايپ نمايیم و يا با فعال کردن DYN و تنظیم units بوسیله موس چهار ضلعی را ترسیم نمايیم.

TRIMدستورپاککردنموضعی

هنگامی که دو يا چند ترس��یم با هم برخورد داش��ته باشند و بخواهیم قس��مت يا بخش هايی از ترسیم را حذف 
نمايیم از اين دستور استفاده می نمايیم

Menubar: Modify> Trim

Toolbar : Modify> Trim

Command:  Trim یا Tr
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 ABبعد از اجرای دستور ابتدا بايستی لبه يا مرزهای برش را انتخاب کرد: مثلا برای پاک کردن پاره خط

خطوط ۱,۲ بعنوان مرزهای برش انتخاب کرده و پس از زدن ENTER پاره خط  AB را انتخاب می نمايیم.

نکته:

اگر در قس��مت انتخاب مرزهای برش <SELECT OBJECT OR >SELECT ALL بدون هیچ انتخابی کلید 
ENTER را بزنیم تمامی ترس��یم بعنوان لبه های برش انتخاب می شوند در اين حالت هر قسمتی را که بخواهیم 

می توانیم حذف نمايیم.

UNDOفرمان

به کمک اين فرمان می توانیم دس��تورات اجرا ش��ده قبلی را لغو نمايیم و يا به بیان ديگر با اجرای هر بار فرمان 
UNDOيک مرحله به عقب باز می گرديم.

Menubar: Edit> Undo
Toolbar : Standard> Undo
Command:  Undo یا U یا Ctrl+z

REDOفرمان

در صورتیکه از  فرمان  UNDO استفاده کرده باشیم به کمک دستور REDO می توانیم دستور مراحل لغو شده 
را باز گردانیم و با اجرای هر بار آن يک مرحله به جلو برويم

Menubar: Edit> Redo
Toolbar : Standard> Redo
Command:  Redo یا Ctrl+y

انتخاب مرزهای برش ..........................

Command:  Trim

SELECT OBJECTS OR>SELECT ALL<۲خطوط ۱و

SELECT  OBJECT TO TRIM:AB انتخاب پاره خط 
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دستورکار1

شکل روبرو را ترسیم نمايیم
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دستور کار 2
شکل زیر را به کمک دستورات فرا گرفته ترسیم نمایید
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۱. فرم��ان line را از چن��د طريق می توان اجراکرد و روش های ترس��یم يک پاره خط را ش��رح 
دهید؟

۲. تنظیمات unit در چه مواقعی کاربرد دارد؟

۳. روش های پاک کردن يک ترسیم را توضیح دهید؟

4. معنای جمله Specify first point چیست؟

۵. اصطلاح خط به زبان انگلیسی ..................................... می شود.

۵- اصطلاح دايره به زبان انگلیسی....................................می شود.

7. برای فعال و غیر فعال کردن DYN از چه کلیدی استفاده می شود؟

F10 )د                    F3 )ج                       F8)ب                     F12)الف

8. برای فعال کردن دستور ORTHO از چه کلیدی استفاده می شود؟

F10 )د                    F3 )ج                       F8)ب                     F12)الف

۹. برای ترسیم دايره به روش دو مماس و شعاع از چه دستوری استفاده می شود؟

Tan-Tan-Radiv )ب                           Tan-Tan-Tan )الف

circle  .  Diameter )د                                      point 3 )ج 

۱0. مخفف دستور Trim چیست؟

الف(T                     ب(Tr                       ج( Tri                    د( هیچکدام

نظری15دقیقه

ارزشیابیپایانی
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شکل های زير را در کاغذ A4 ترسیم کرده و هر کدام را با نام متفاوتی ذخیره نمايید.

عملی15دقیقه

ارزشیابیپایانی



7۵
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توانایی2:تواناییاجرایدستوراتترسیمیوویرایشی

Arc-Osnap-Copy-Move-Fillet-Chamfer-List-Dist-Grip

اهدافرفتاری:

پسازآموزشاینتواناییازفراگیرانتظارمیرود:

۱. معنای کاربردی دستورات و فرامین اين قسمت را بداند.

۲. توانايی ترسیم کمان برش های مختلف را فرا گیرد.

۳. توانايی استفاده از گیره های شی :Objectsnap در ترسیم را فرا گیرد

4. مشخصات يک ترسیم را با استفاده از دستور List استخراج نمايد.

۵. توانايی اندازه گیری فاصله بین دو نقطه را با استفاده از دستور Dist فرا گیرد.

6. از خطوط کمکی Tracking در ترسیم يک شکل استفاده نمايد.

7. توانايی جابجايی يک ترسیم را با استفاده از دستورات Grip،Move،Copy فرا گیرد.
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پیشآزمون

    ۱- برای پاک کردن پاره خط AB و سپس BC از چه دستوراتی بايستی استفاده کرد؟

                                  ۲ - اگر شکلی را توسط دستور Erase پاک کرده باشیم  به کمک چه دستوری می توان آن را باز گرداند.

               ۳- نقاط Grip را چگونه می توان فعال کرد؟

               4- جهت جابجا کردن يک ترسیم بکمک نقاط Grip چه عملی را بايستی انجام داد.

               ۵- به کمک چه دستوری می توان شکل روبرو را ترسیم کرد.

         

               6- روش های اجرای يک دستور را توضیح دهید.

C

B

A

R۵0  

۵0  

۵0  
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Start             شروع

Point            نقطه

Center           مرکز

End   انتها

Lenght   طول وتر

Continue   ممتد

Arc   کمان

Object snap   گیره های شی

Copy   کپی

Move   جابجايی

Fillet   گرد کردن گوشه

Chamifer   پخ زدن گوشه ها

List   مشخصات ترسیم

Dist   فاصله

Grip   نقاط کمکی

Tracking   خطوط کمکی

Base point   نقطه مبنا

End point   نقطه ابتدا و انتهای خط پايان يا کمان

Midpoint   نقطه میانی

Tangent   مماس

Intersection   محل برخورد

Perpendicular   عمود

Parallel   موازی

Angle   زاويه

Radius   شعاع

Circumference   محیط

Area   مساحت
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Arcفرمان-

به کمک اين دستور می توان يک کمان به روش های مختلف ترسیم کرد.

اگر دس��تور کمان را در خط فرمان تايپ نمايیم در اين صورت با انتخاب س��ه نقطه می توان يک کمان رسم کرد 
هم چنین اجرای دستور کمان از قسمت نوار ابزار نیز به همین صورت اجرا می شود.

فرمان کمان را می توان به روش های زير اجرا کرد.
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)Object snap(osnapابزارهای-

به کمک اين ابزار می توان نقاط مشخصی از شکل را انتخاب کرد و در ترسیمات جديد مورد استفاده قرار داد به 
عنوان مثال می خواهیم يک دايره در وس��ط يک خط ايجاد نمايیم و يا از مرکز يک دايره خطی به مرکز دايره ای 

ديگر ترسیم نمايیم. ابتدا لازم است نقاط يک ترسیم شناخته شود.

Osnapفعالکردن-

به چند طريق زير می توان گیره های شی را فعال کرد

۱-در قس��مت Status bar بر روی Osnap کلیک راس��ت کرده و گزينه Setting را انتخاب می کنیم تا پنجره 
مربوطه باز شود سپس در قسمت Object snap موارد مورد نیاز را تیک می زنیم تا به طور دائمی فعال شود.
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۲- هنگام ترسیم می توان به طور موقت از اين گیره ها استفاده کرد برای اين منظور نوار ابزار Object snap را 
فعال می کنیم .)بر روی يکی از آيکون ها کلیک راست کرده و گزينه Object snap را تیک می زنیم(

۳-روش ديگر اس��تفاده موقت از گیره های ش��ی استفاده از CTRL و کلید س��مت راست موس می باشد در اين 
حال��ت پنجره ای ظاهر می ش��ود که اب��زار های Snap در آن قرار دارد در اين حال��ت می توان گزينه مورد نظر را 

انتخاب کرد.

نکته:

با انتخاب روش اول گزينه هايی که در پنجره Osnap  تیک خورده اند به طور دائم فعال می باشند .

                       نکته:با انتخاب روش دوم و سوم فقط يک بار از Osnap مورد نظر می توان استفاده کرد.
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Move ،Copyفرمانهای-

با استفاده از اين فرامین می توان يک ترسیم را کپی نمود يا جابجا کرد.

اجرای فرمان

Menubar :Modify< Copy or Move

Command:Copy or Move

بعد از اجرای فرمان، موضوع يا موضوعات )Select Objects( را به وس��یله موس انتخاب کرده و کلید Enter را 
می زنیم. س��پس يک نقطه به عنوان مبنای حرکت را به وس��یله موس و به کمک Osnap انتخاب می نمايیم و در 

آخر نقطه مقصد را مشخص می کنیم.

- می خواهیم دايره ترس��یم  ش��ده در گوش��ه مس��تطیل را به گوش��ه ديگر انتقال داده و يا در گوشه ديگر ايجاد 
نمايیم.
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Chamfer ،Filletفرمان

برای گرد کرد ن گوشه ها از دستور Fillet ، و برای پخ زدن گوشه ها از دستور Chamfer استفاده می شود.

Menubar:Modify<Fillet Chamfer

Toolbar:Modify<

بعد از اجرای دس��تور Fillet مقدار ش��عاع را وارد کرده و سپس دو موضوعی که می خواهیم بین آن ها Fillet زده 
شود انتخاب می  نمايیم.

Command:Fillet

Select First Object or )Undo/  polyline/Radius/Trim( :R

Specify Fillet R adus

نکته:اگر مقدار R در دستور Fillet منو داده شود دو شکل به صورت تیز به هم می رسند.

برای پخ زدن گوشه ها به دو روش زير می توان عمل کرد.
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۱- تعیین فاصله عمودی و افقی پخ

۲- تعیین طول خط )در راستای انتخاب اول( و زاويه پخ

Listفرمان

به کمک اين دستور می توان مشخصات يک ترسیم را از قبیل طول پاره خط، زاويه خط، مختصات نقاط شروع و 
پايان خط، مرکز دايره، شعاع دايره، مختصات مرکز دايره، مساحت و محیط دايره را به دست آورد.

برای اين منظور کافیس��ت ترس��یم مورد نظر را انتخاب کرده و دس��تور List را در قس��مت Command تايپ 
نمايیم.
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Distفرمان

به کمک اين دس��تور می توان فاصله دو نقطه را به دس��ت آورد برای اين منظور دس��تور را اجرا کرده و به کمک 
موس و ابزار Osnap دو نقطه را انتخاب می نمايیم فاصله طولی ،افقی و عمودی دو نقطه نمايش داده می شود.

Gripفرمان

Grip مربع های آبی رنگی می باش��ند که هنگام انتخاب يک ترس��یم به وسیله موس ظاهر می شوند.اگر موس را 

ب��ر روی مربع ه��ای کناری قرار داده و کلیک نمايیم مربع آبی رنگ، قرمز می ش��ود و در اين حالت قادر به تغییر 
اندازه ترسیم می باشیم.

به کمک مربع های میانی می توان ترسیم را جابجا کرد و عملیات Move را انجام داد.

 

                         نکته:اگر در حالتی که مربع قرمز رنگ می باشد کلیک راست نمايیم پنجره ای ظاهر می شود 
که به کمک دستورات آن می توان عملیاتی نظیر Rotate،Move،Copy را بر روی ترسیم انجام داد.
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دستورکار1

مطلوب است ترسیم شکل روبرو
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تئوری

آزمونپایانی

۱- در ترسیم کمان منظور از Lenght چه اندازه ای می باشد؟

     الف( قطر کمان          ب( قطر کمان           ج( شعاع کمان        د(وترکمان

۲- برای مماس کردن يک پاره خط به دو دايره از کدام Osnap استفاده می شود.

Line:Tan،Tan)الف

Line:End،End)ب

Line:Quadrant،Tangent)ج

Line:Tangent،Endpoint)د

۳- برای رساندن دو پاره خط به يکديگر از چه دستوری می توان استفاده کرد؟

Trim)الف

Grip)ب

Fillet)ج

Chamfer)د

4- جهت اندازه گیری فاصله دو گوشه يک مستطیل از دستور .............. استفاده می شود.

۵- جهت انتقال سريع وسط يک خط به مرکز يک دايره از نقاط ........... استفاده می شود.

Quadrant -6 چهار نقطه اصلی ................. نام دارد.
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                   مطلوبست ترسیم  مرحله ای شکل های زير 
عملی

آزمونپایانی
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توانایی3:تواناییاجرایدستوراتترسیمیوویرایشی

Rotate-Scale-Array-Mirror-Offset-Hatcth-Ucs

اهدافرفتاری

پسازآموزشاینتواناییازفراگیرانتظارمیرود:
۱- معنای کاربردی دستورات و فرامین اين قسمت را بداند.

۲- توانايی دوران دادن يک شغل و تغییر مقیاس آن را دارا باشد.
۳- توانايی تکثیر يک شغل  به صورت سطری ستونی و دايروی داشته باشد.

4- توانايی ايجاد تصاوير آينه ای و با فاصله مشخص را داشته باشد.

۵- انواع خطوط هاشور را بشناسد و توانايی هاشور زدن و ويرايش آن را بداند.

۱- به کمک نقاط کمکی Grip چه دستوراتی را می توان انجام داد.

۲- در کدام قسمت می توانیم Osnap های مشخصی را  به طور ثابت فعال نمايیم.

۳- برای فعال و غیر فعال کردن Osnap از کدام کلید تابعی استفاده می نمايیم.

4- می خواهیم محیط و مساحت يک مستطیل به ابعاد ۵0×۱00را به دست آورديم.

برای اين منظور از چه دستوری استفاده نمايیم.

۵- مختصات ابتدا و انتهای يک خط عبارت اس��ت از )B)60/۹0(، A)۲0/۳0 به کمک کدام دس��تور 
می توانیم طو ل و زاويه خط را به دست آورديم.

6- اگر بخواهیم چهار گوشه يک مستطیل با اجرای يک دستور Fillet گرد شوند به چه طريقی بايد 
عمل نمايیم.

پیشآزمون
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واژهنامه

Rotate   دوران
Scale   مقیاس
Base point   نقطه مبنا
Rotation angle   زاويه دوران
Scale Factor ضريب بزرگنمايی
Rectangular Array   تکثیر سطری و ستونی
Polar Array   تکثیر دايروی
Row سطر
Column   ستون
Origin   مبدا
Mirror تصوير آينه ای -متقارن
Hatch   هاشور

Rotateفرمان

برای دوران يک ترسیم حول يک مرکز از اين دستور استفاده می شود.

Menubar:Modify<Rotate

Command:Rotate   or Ro
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نکته:مرکز دوران را با توجه به شکل ترسیم بايستی انتخاب کرد.

                          

                                نکته:بعد از انجام Rotate شکل اولیه حذف می گردد چنان چه اگر به شکل اولیه نیاز داشتیم.

می توانیم قبل از وارد کردن مقدار زاويه حرف C مخفف Copy را وارد کرده و بعد از زاويه را وارد نمايیم.

Specify Rotation angle or ]copy / Reference[ :c

Scaleفرمان

به کمک اين دس��تور می توانیم مقیاس يک ش��کل يا ترس��یم را تغییر دهیم يعنی آن را بزرگ تر يا کوچک تر 
نمايیم.

Menubar:Modify<Scale

Command:Scale or Sc
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ARRAYفرمان

برای تکثیر يک شکل به صورت سطری و ستونی و يا دايروی از اين دستور استفاده می شود.

Menubar:Modify<Array

Command:Array  or  AR

بعد از اجرای دستور پنجره زير نمايان می شود که ابتدا بايستی در قسمت Select Objects موضوع مورد تکثیر 
را انتخاب نمايیم و با زدن کلید Enter به پنجره Array بازگشته و ساير تنظیمات را انجام دهیم.

- تکثیر سطری و ستونی
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-تکثیردایروی

 Select تیک می زنیم و در قسمت Polar Array در اين حالت بعد از اجرای دستور در پنجره نمايان شده قسمت
Object موضوع يا موضوعاتی که می خواهیم به صورت دايروی تکثیر ش��وند انتخاب کرده و Enter  را می زنیم 

سپس تعداد موضوعات و زاويه تکثیر را تعیین می نمايیم.
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MIRRORدستور

به کمک اين دستور می توان يک ترسیم آينه ای ايجاد کرد يعنی نسبت به يک محور تصويری متقارن ايجاد کرد.

Menubar:Modify<Mirror

Command:Mirror or Mi

 Osnap نکته:برای انتخاب محور متقارن می توانیم دو نقطه از يک ش��کل را با اس��تفاده از
انتخاب نمايیم و همیشه لازم  به رسم يک محور تقارن نمی باشد.
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Offsetدستور

از اين دستور برای ايجاد تصاوير موازی و با فاصله مشخص استفاده می شود.

Menubar:Modify < Offset

Command:Offset  or  O

نکته:در صورتی که نخواهیم عملیات Offset تکرار شود کلید Enter را می زنیم.
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برای هاشور زدن شکل های بسته از اين دستور استفاده می شود.

Menubar:draw<Hatch

Command:Hatch   or   H

نکته:برای ويرايش کافیست بر روی هاشور دوبار کلیک نمايیم.
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UCSدستور

برای جابجايی محور مختصات بر روی شکل از اين دستور استفاده می شود.

محور مختصات در هر جای ش��کل قرار بگیرد آن نقطه )صفر و صفر(در نظر گرفته می ش��ود و مابقی نقاط نقشه 
نسبت به محور مختصات سنجیده می شود برای اين منظور کافیست دستور Origin از نوار ابزار Vcs را انتخاب 

کرده و نقطه مورد نظر بر روی ترسیم را به کمک Osnap انتخاب نمايیم.

فرض کنید می خواهیم محور مختصات در مرکز دايره قرار گیرد.

نکته:برای به دست آوردن مختصات چهار نقطه )Quadrant( دايره کافیست بر روی دايره 
کلی��ک نمايیم تا نقاط Grip بر روی آن ظاهر ش��ود ح��ال با قرار دادن موس بر روی هر مربع مختصات ان نقطه 

نسبت به مرکز تغییر پیدا می کند.
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عملی

آزمونپایانی

شکل های زير را رسم نمايیم و سپس با قرار دادن مختصات بر روی يک نقطه دلخواه ساير 
مختصات نقاط را استخراج کرده و برنامه آن را بنويسید.
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    واحد کار

پنجم
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هدفکلی:آشناییباسیستمهایتولیدییکپارچهکامپیوتری

اهدافرفتاری:
پسازآموزشاینتواناییازفراگیرانتظارمیرودکهبتواند:

۱. انواع روش تولید در صنعت را شرح دهد.

۲- سیستم های کنترل عددی  را توضیح دهد.

۳- کاربرد کنترل عددی در ماشین های افزار را شرح دهد. 

4- اصول ايمنی با دستگاه را نام ببرد.
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NCآشناییباسیستمهایکنترلعددی
تا پیش از دهه ۵0 میلادی دونوع روش تولید در صنعت موجود بود

– تولیدتکییادستهای:
   در اي��ن روش تولید بوس��یله ماش��ین های ابزار،  به ص��ورت مکانیکی و 
بوس��یله اپراتور انجام می ش��ود و دقت ابعاد نهايی قطعه کار  کاملا  وابسته به 

دقت ومهارت اپراتور می باشد.

بههمیندلیلمعایبزیربوجودمیآید:

 - سرعت پايین تولید

- يکسان نبودن ابعاد قطعات مشابه 

–تولیدانبوه:
در اين روش قطعات با حجم تولید کم يا متوسط وبا عملیات دستی تولید می شوند

    در اين روش قطعات با کیفیت مناسب تر و با تعداد زياد تولید 

   می شود اما برای ايجاد تغییر در نوع تولید لازم است تا تغییرات 

  زيادی در ماشین ها، ابزارها وقید و بندها صورت گیرد. 

در اين روش قطعات با حجم تولید بالا به صورت خودکار و با طراحی ثابت تولید می شوند

البت��ه کیفیت قطعات تولیدی در هر دو روش قابل قبول و پاس��خگوی نیازهای آن زمان بود. در آن ش��رايط 
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لازم بود تولید يک محصول به مرور زمان با  اصلاح کیفیت، بهبود عملکرد افزايش قابلیت ها وحتی قابلیت شکل 
ظاهری آن همراه شود.و در اين صورت تولید خودکار قديمی جوابگوی اين نیاز نبود. 

از طرف��ی ديگر پس از جنگ جهانی دوم، در س��اخت محصولاتی  
مثل هواپیما و اتومبیل های پیش��رفته از قطعاتی اس��تفاده شد که 
دارای ش��کل های پیچیده بوده و دقت تولید بالايی را می طلبیدند و 
تولید اين قطعات بوسیله ماشین های ابزار معمولی امکان پذير نبود.

در نتیجه برای پاسخگويی به نیازهای پیش آمده، اولین ماشین 
کنترل عددی )NC( در دانش��گاه ماساچوست)MIT( ساخته شد 
اين ماش��ین های کنترل عددی قادر به کنترل تنها يک محور بودند 
اما به مرور زمان قابلیت کنترل سه محو.ر حرکتی را نیز پیدا کردند.

NCتعریففنآوری-

به بیان ساده NC يا کنترل عددی عبارت است از بکارگیری کدهای ويژه ای شامل اعداد،حروف وعلائم 
برای کنترل عملکرد ماشین و ساخت قطعات و ايجاد اتوماسیون.

برای مثال يک بلوک)ش��امل اعداد، حروف وعلائم( می تواند به يک ماش��ین NC دس��تور دهد که اسپیندل 
دستگاه با سرعت دورانی وپیشروی مشخص به نقطه ای حرکت نمايد.

با اجرای خط فرمان زير اسپیندل دستگاه با سرعت ۱00میلیمتر بر دقیقه به مختصات مشخص شده Z،Y،X می رود                                                                                         

N10   G01  X80  Y50   Z10  F10:

در ماشین هایNC اولیه از نوار کاغذی سوراخ دار

 برای کنترل حرکت محورها استفاده می شد. 

بدين ترتیب که اطلاعات حرکتی و ماشین کاری در 
قسمت های مشخصی برروی نوار کاغذی سوراخ می شود 
و بعد از اتمام کار نوار متش��کل از برنامه ماشین کاری به 

دستگاه نوار خوان انتقال داده می  شود.
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  NCدر دستگاه نوار خوان اطلاعات بر روی کاغذ ،رمز گشايی شده وبه صورت پالس های الکتريکی به دستگاه
منتقل می شود . دستگاهNC عملیات ماشین کاری را انجام می داد                                                                                                             

  

 NC هنگام پانچ هر برنامه، کاغذ پانچ به تدريج از ماشین خارج می شود و به واحد کنترل ماشین

   )MCU  )Machine  Control  Unit وارد می ش��ود. اين ماش��ین دارای حافظه نمی باشد و فقط قادر است 
يک بلوک از دستور را خوانده و برای اجرا به دستگاه NC منتقل کند با استفاده از اين رشته های نوار پانچ 

قادر خواهیم بود هر تعداد از يک نوع قطعه را تولید نمايیم.

اکثر ماش��ین های NC برای عملیات ماش��ین کاری احتیاج به کددهی توس��ط س��وراخ هايی بر روی نوارهای 
کاغذی داشت. 

که با گسترش صنعت اين عملیات مشکلاتی را از قبیل: صرف زمان زياد، امکان ايجاد خطا، عدم امکان ساخت 
قطعات پیچیده  را به همراه داشت.

اين روش ادامه داشت تا اينکه در دهه 60 ايده کددهی وکنترل عددی توسط کامپیوتر مطرح گرديد. در اين 
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سیستم ديگر نیازی به استفاده از نوار سوراخ دار و ديسکت جهت ذخیره و انتقال اطلاعات نبود و برنامه مستقیما 
از کامپیوتر توسط کابل به کنترل ماشین منتقل می شد.

به اين روش انتقال اطلاعات کنترل عددی مستقیم گفته می شود

)Direct Numerical Computer(DNC

در اين روش اطلاعات از طريق يک کابل به نام RS۲۳۲ به دستگاه منتقل می شود

در ده��ه 70 ب��ا کاهش ابعاد ريز پردازنده ها يک کامپیوتر به کنترل NC اختصاص داده ش��د وکنترل عددی 
کامپیوتری يعنیCNC بوجود آمد.

CNC  )Computer  Numerical  Control(
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کامپیوتر در س��ازمان واحد کنترل ماش��ین 
جاگرفت��ه واجازه می ده��د برنامه ه��ا از طريق 
نرم افزارش��ان به وجود  آيد و در حافظه ذخیره 

شوند. 

پس از يک بار نوش��تن برنامه، هرچندبار که 
لازم باش��د با رجوع به حافظه اجرای آن امکان 

پذير است.

ب��ه کارگیری ماش��ین های CNC علاوه بر 
افزاي��ش دو روش قدي��م تولی��د )تولید تکی و 
انبوه( امکان تولید قطعات به صورت نیمه انبوه 
و پیچی��ده را فراهم می آورد که از نظر اقتصادی 

توجیه پذير است..

CNCاجزایاصلیماشینهای
بطور کلی ماشین ابزارCNC از سه بخش عمده نرم افزار ،واحدکنترل و سخت افزار تشکیل شده اند

1-نرمافزار

شامل برنامه ماشین و مجموعه ای از اعداد،حروف

 و نشانه هايی اس��ت که به ماشین می گويد چه عملی بايد انجام 
دهد

اين برنامه شامل اطلاعاتی نظیر روش ومسیر ماشین کاری

قطعه،مقادير سرعت دوران ، پیشروی ،دستور روشن وخاموش 
کردن موتورها و .... می باشد.

نوار سوارخدار
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اطلاعات از روش های زير به دستگاه منتقل می شود:

- نوار سوراخدار

 -نوار مغناطیسی

 -ديسک مغناطیسی

)MDI(از طريق صفحه کلید دستگاه -

     MDI=Manual Data Input

در اين روش اطلاعات را مس��تقیما با اس��تفاده از صفحه کلید نصب 
برروی دستگاه منتقل می کنیم

 DNCاستفاده از کامپیوتر-   

UnitControlMachine)UCM(2-واحدکنترل

اين قس��مت در حقیقت اصلی ترين قسمت ماش��ین های کنترل عددی 
می باشد .صدور و قطع کلیه فرمان های ماشین کنترل عددی در اين قسمت 

صورت می گیرد.

 در حقیق��ت اين قس��مت برنامه نوش��ته ش��ده به صورت علائ��م و...را 
رمزگشايی کرده و به برنامه حرکتی تبديل می نمايد و عملیات ماشین کاری 

را کنترل می نمايد.

نوار مغناطیسی

برنامه وارده به صورت کدهای رمز بندی شده می باشد که پس  
از ورود به دس��تگاه در واحد کنترل تفسیر می شود و برای اجرا به 

دستگاه منتقل می گردد.

ديسک مغناطیسی

صفحه کلید دستگاه

کنترل فانوک
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کنترلر ه��ای ماش��ین های CNC ب��ا توجه به اس��تانداردهای 
مختلف��ی که وجود دارند س��اخته می ش��وندکه معروف ترين آن ها 
کنترل های زيمنس، فانوک،هايدن های،میتسوبیشی، فاگور، فیديا،  

انگل هارد، هاست، تسلاو... می باشد..

اجزای واحد کنترل عبارت است از :

RAMحافظه،CPU،نوارخوان،میکروپروسسور  -

حافظهPLC ،ROM، تقويت کننده،تابلوی کنترل و...

3-سختافزارماشینهایکنترلعددیشاملدوقسمتزیرمیباشد:

-بخشمکانیکی:

   شامل بدنه، میز،کله گی، سیستم انتقال حرکت شامل جعبه دنده،  پیچ های،  راهنما ، سیستم ياتاقان بندی 
و.. می باشد.

در ماشین های سنتی معمولاً از پیچ های رزوه ذوزنقه ای برای

 تامین حرکت پیشروی کشويی و میز استفاده می شود ولی در

ماشین های CNC از پیچ های ساچمه ای استفاده می گردد.

 قلب يک سیستم پیشروی در ماشین های CNC پیچ و مهره

 ساچمه ای می باشد. هنگامی که حرکت دورانی از موتور به

 پیچ منتقل می شود، میز ماشین از طريق مهره، حرکت خطی

 پیدا می کند. 

کنترل زيمنس
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-بخشالکترونیکی:

  اين بخش شامل سیستم محرکه)موتورهای الکتريکی( 
وسیستم اندازه گیری تقسیم بندی می شوند.

- سیستم محرکه: در ماشینCNC از سه نوع سیستم 
محرک��ه الکتريک��ی، هیدرولیک��ی و پنوماتیکی اس��تفاده 

می شودکه نوع پنوماتیکی آن استفاده نمی شود.

 Stpping Motorsموتورهای پله ای -

اين موتورها دارای س��اختمان ساده ، کم حجم و قیمت مناسب 
می باشد. از آن ها در CNC های ساده با دقت محدود وگشتاورهای 

نسبتاً کم و قدرت کمتر از hp۱ استفاده مي شود
موتور پله ای
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 ) DC (موتورهای جریان مستقیم -

موتورهای DC بیشــترین اســتفاده را در ماشــین های  CNCدارند این 
موتورها دارای قدرت بالا، ســرعت یکنواخت و عکس العمل سریع نسبت به 

تغییرات سرعت مي باشند

 ) AC (موتورهای جریان متناوب-  

در موتورهای AC کنترل دور با تغییر فرکانس می باشد 

     این امر هزینه بسیار بالایی را نسبت به موتورهای DC در بر دارد.   
عدم نیاز به یک سو کننده تعمیر و نگهداری ارزان تر به دلیل نداشتن 

کلکتور و جاروبک از مزایای این موتورها می باشد

 

- محرکه های هیدرولیکی:

کنترل قدرت های زیاد با نیروی کم سادگی کنترل  سرعت 
و نیرو به طور پله ای و عکس العمل ســریع در برابر تغییر جهت 
از ویژگی های محرك های هیدرولیکی می باشند. از معایب آن ها 
نشــتی و قیمت گرانشــان می توان نام برد و نیز این سیستم ها 
دارای ســرعت عمل کمتری نســبت به محرکه های الکتریکی 

می باشند.

- سیستم اندازه گیری

 برای کنترل عملیات ماشــین کاری پارامترهای موقعیت، سرعت 
و نیرو توسط سنسورهای موقعیت دیجیتالی اندازه گیری می شوند. 

این سنسورها در سه نوع انکودر زاویه  ای، انکودر چرخشی و خطی 
ساخته  می شوند و در یکی از محل های زیر نصب می گردند.

DC موتور جریان مستقیم

موتور جریان 

محرکه هیدرولیکی

Heidenhain انکودر خطی مدل



111

انتهای محور موتور  -1

انتهای محور پیج ساچمه ای  -2

میز ماشین  -3

CNC انواع ماشین افزار
این ماشین ها بسیار متنوع بوده و جهت کارهای مختلفی ساخته  می شوند که به شرح زیر می باشد.

: CNC 1- دستگاه های فرز

این دســتگاه ها در مدل های دروازه ای، سنتروبورینگ ساخته  می شــوند. محورهای این دستگاه ها با توجه به 
کاربرد از 2 تا 6 محور خطی و دورانی ساخته  می شوند.

 

Heidenhain انکودر چرخشی مدل

فرز CNC با 3 محور کنترلفرز مدل دروازه ای با 2 محور کنترل

فرز مدل دروازه ای با 4 محور کنترل
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CNC2-ماشینهایتراش

بوسیله اين دستگاه ها می توان انواع قطعات مدور تولید کرد.

اين دستگاه ها دارای دو محور حرکتی xوz می باشند که ابزار با حرکت در اين ۲ محور قطعه مورد نظر را

تولید می نمايد.

CNC نمونه ای از قطعات ساخته شده بوسیله دستگاه تراش CNC محورهای حرکتی دستگاه تراش

دستگاه تراش CNC با کنترل زيمنس
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:CNC 3-ماشین های اسپارک 

  این ماشین ها در دو نوع غوطه وری و سیمی )وایر کات( 
ساخته می شوند. به کمک این ماشین ها می توان قطعات 

پیچیده را تولید کرد.

در دستگاه های وایرکات ابتدا شکل قطعه در نرم افزار

طراحی می شود و سپس به دستگاه منتقل می شود.

دستگاه عمل ساخت را به وسیله یک سیم مسی مصرفی

و عمل تخلیه الکتریکی انجام می دهد.

در دستگاه های اســپارك برای ساخت یک قطعه ابتدا 
بایستی شکل معکوس آن را برروی یک قطعه مسی ساخته 

و به  وسیله عمل تخلیه الکتریکی قطعه نهایی ایجاد شود.

مدل مسی دستگاه اسپارك

CNCدستگاه وایرکات

HS`HV;CNCدستگاه
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CNC 4- ماشین های سنگ زنی

اینماشینهادرسهنوعساختهمیشوند

1-ماشینهایسنگزنیگردسا

2-ماشینهایسنگزنیکفسا

3-ماشینهایسنگزنیابزارتیزکنی

CNC 5- ماشین های خم کنی

اینماشینهااکثراًدارای3محورکنترلمیباشند

وازآنهادرصنایعمختلفاستفادهمیشود.

ماشینسنگزنیگردسا

ماشینسنگزنیابزارتیزکنی ماشینسنگزنیکفسا
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CNC6-پرسهای

از ماشین های پرس CNC نیز در صنايع نظامی برای

ساخت بال ها،در صنايع خوروسازی،وبرای ساخت

انواع صندلی و...بکار می رود.

CNC دستگاه خم کن
CNC نمونه ای از قطعات خم شده توسط دستگاه

CNC قطعه تولید شده بوسیله دستگاه پرس

CNC دستگاه پرس
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CNC7-ماشینهایپانچ

اين ماشین ها دارای کنترل نقطه ای می باشند و می توان 
بايک سنبه، شکل های مختلفی را برش داده و ايجاد کرد.

با توجه به اينکه از يک س��نبه کوچک برای برش يک 
س��طح بزرگ استفاده می ش��ود نیروی برش به مقدار قابل 

توجهی کاهش می يابد

در اين روش ابتدا ش��کل مورد نظر در يک محیط نرم 
افزاری ۲ بعدی ترس��یم می شود وبعد از نوشتن برنامه آن 
به دس��تگاه منتقل می گردد سپس با توجه به ابعاد قطعه 
،س��نبه مورد نظر انتخاب شده و سنبه با برش های کوچک 

قطعه مورد نظر را از ورق جدا می نمايد.

ماشین های دريل CNC دارای کنترل نقطه ای

می باشند. 

CNC نمونه های سنبه های دستگاه پانچ

CNC دستگاه پانچ

CNC قطعات تولید شه بوسیله دستگاه پانچ
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Plasma8-ماشینهایبرشلیزر

به کمک اين دستگاه ها می توان شکل های مختلف

را با استفاده از اشعه لیزر با دقت بالا تولید کرد.

Waterjet9-ماشینهایبرشباآبواترجت

در اين ماشین ها آب بافشار زياد از يک نازل به سطح 
قطعه کار خورده و عملیات برش انجام می شود

از اي��ن فرآين��د عمدتا ب��رای برش کاری م��واد نرم 
غیرفلزی مانند مواد مصنوعی،چرم،چوب،کاغذ واس��فنج 

استفاده می شود.

CMM10-ماشینهایاندازهگیری3بعدی

               CMM=Coordinate Measurment Machine

با استفاده از اين ماشین ها می توان يک قطعه صنعتی 
را به طور دقیق اندازه گیری کرد.

CNC اندازه گیری ابعاد بدنه يک ماشین بکمک
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اســاس کار بدین صورت است که یک حساسه از 
جنس یاقوت با نقاطی از قطعه تماس ایجاد می کند. 

و مختصات آن را به دست می آورد.

از ایــن دســتگاه ها در مهندســی معکوس نیز اســتفاده 
می کنند بدین ترتیب که با استفاده از نقاط اندازه گیری شده 
و انتقــال آن به نرم  افزارهای طراحی شــکل قطعه مورد نظر 

ایجاد می شود. 

با توجه به شــکل برای طراحی و ترسیم قطعه روبرو ابتدا 
بکمک دســتگاه اندازه گیر 3 بعدی مختصات نقاطی از سطح 
استخراج می شود و در نرم افزار مربوطه مثلًا )Catia( بکمک 

این نقاط سطوح ترسیم شده و شکل ایجاد می شود.

CNC محورهای ماشین های
- سیستم مختصات

   برای تعریف موقعیت یک نقطه خط، منحنی، صفحه  
و حجم به سیســتم مختصات نیازمندیم. در این  سیستم 
سه محور مختصاتی تعریف شده  است که به یکدیگر عمود 

بوده و با حروف Z،Y،X تعریف می شوند.  

 در ماشین های CNC نیز باید تمامی نقاط ماشین کاری 
برای دســتگاه قابل شناســائی باشــد تا ابــزار بتواند در 
محدوده ماشین کاری دستگاه با توجه به مختصات تعریف 
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شده)Z،Y،X( حرکت نمايد.

- محورهای اصلی 

 CNC بط��ور کل��ی منظور از مح��ور در ماش��ین های
راس��تای حرکت��ی میز يا اب��زار در مس��یرهای محورهای 

مختصات می باشد.

 ماش��ین های ت��راش CNC دارای دو مح��ور کنترلی 
می باش��ند زيرا اب��زار فق��ط در دو جهت طول��ی وعرضی 
می توان��د حرکت کند در ماش��ین های تراش CNC محور 
Z ب��ر محوراصلی )اس��پیندل( و يا مح��ور دورانی منطبق 

می باشد

- نحوه شناسائی محورهای اصلی

 برای تعین جهت محورهای يک دس��تگاه فرزCNC از قانون دست راست 
به صورت زير اس��تفاده می نمائیم. ابتدا روبروی دس��تگاه ايستاده و سه انگشت 
میانی، اشاره و شصت را عمود بر هم قرار می دهیم در حالتی که انگشت میانی 
در راس��تای محور اسپیندل ماشین باش��د در اين حالت انگشت شصت جهت 
مثبت محور X و انگش��ت اش��اره جهت مثبت محورY وانگش��ت میانی جهت 

مثبت محور Z را مشخص می نمايد

- محورهای چرخشی

  علاوه بر سه محور Z،Y،X سه محور چرخشی حول محورهای 
Z،Y،X وجود دارد که بنام های C،B،Aمی شناسیم.
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 اســاس اختصاص این محورها بدین علت اســت که 
ابزار بتواند در تمامی جهات حرکت کرده و پیچیده ترین 

شکل ها را ماشین کاری کند

 نکته: هنگام کار با دستگاه فرز CNC بایستی به این نکته توجه کرد که حرکت محورها 
در جهت های X و Z, Y توسط میز و اسپیندل انجام می شود.
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CNC نقاط مرجع در ماشین های
در ماشین هایCNC به منظور حرکت دقیق ابزار ، ماشین کاری دقیق یک قطعه، تنظیم سیستم اندازه  گیری 

و ساده تر شدن برنامه نقاطی را به عنوان نقاط مبداء یا نقاط صفر قرار می دهند.

  Refrence point)نقطه مرجع)رفرنس -

بر روی ماشــین ها ابزار CNC نقطه ای به نام نقطه 
مرجع ماشین یا مکان اولیه وجود داردکه توسط سازنده 
ماشین تعریف می شود و برای تنظیم و هماهنگ کردن 
سیســتم مکانیکی ماشین با سیســتم کنترل آن مورد 
استفاده قرار می گیرد. نقطه مرجع ماشین با حرف R و 

نماد مشخص می شود.

ماشــین CNC هرگاه که روشــن می شود)چه در 
ابتدای روز و چه پس از قطع برق( قادر به شناســایی موقعیت خود نمی باشــد و نیــاز به تنظیم دارد این کار را 

اصطلاحاً رفرنس کردن ماشین می گویند که به وسیله چند کلید انجام می شود.

  Tool refrence pointنقطه صفر ابزار-  

  این نقطه  در موقعیت خاص از ابزارگیر تعریف شده است و تصحیح و جبران شعاع طول 
و شعاع ابزار در راستای هریک از محورهای x،y و یا z نسبت به این نقطه محاسبه می شود.

نقطه صفر ابزار با حرف T و نماد  مشخص می شود.
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 Machine zero pointنقطه صفر ماشین  -  

 اين نقطه توس��ط ش��رکت سازنده بر روی دستگاه تعريف می شود، قابلیت جابجايی نداشته و هنگامی ماشین 
روشن می شود دستگاه موقعیت خود را از اين نقطه می شناسد.

نقطه صفر در ماش��ین های فرز معمولا در گوش��ه س��مت چپ و پايین میز تعريف می ش��ود و لازم است برای 
اطمینان از آن حتما به کتاب راهنمای ماش��ین مراجعه ش��ود که معمولا با علامت   يا حرف M مشخص 

می شود.

 Worlk part zero pointنقطه صفر فطعه کار  -  

اين نقطه توس��ط برنامه نويس تعیین می شود و ماشین کاری از اين نقطه شروع می شود معمولا برای قطعات 
مدور ، مرکز قطعه و برای قطعات مکعبی ش��کل ريا ،گوش��ه س��مت چپ و پايین قطعه کار به عنوان صفر در نظر 
گرفته می شود. که اين نقطه با علامت   و حرف w  مشخص می شود. اگر برنامه نويس نقطه ای را مشخص 

نکند، ماشین کاری نسبت به صفر ماشین انجام می شود و اين امر مشکلاتی را در بر خواهد داشت.
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اصولایمنی

۱- کار را با ياد خدا و با آرامش آغاز کنید و در هر حادثه خونسردی خود را حفظ کنید.

۲- ش��ما با يک سیس��تم اتوماسیون کار می کنید و بايد مراقب فرمان های خود باشید. در سیستم های دستی، 
مجری فرمان انسان است و شعور دارد. در واقع فرمان اشتباه را تشخیص می دهد ولی؛

   CNCفرمان بی کم و کاست اجرا می شود. دستگاه ، CNC در سیستم اتوماسیون شده و بالاخص در دستگاه 
يک پرسنل مطیع و بی رحم است .پیش بینی شوک های ناگهانی، هنگام تعمیر و تعويض قطعه و ابزار را بنمائید.

۳- يکی از مش��کلات رايج در بین طراحان و اپراتورهای س��ی ان سی مشکلات ناشی از نشستن طولانی روی 
صندلی است دقت کنید، بیماری های فرسايشی ناشی از کار معمولا غیر قابل درمان هستند.

4-  اتفاقات مکانیکی بیش��تر مربوط به محور Z اس��ت. زيرا در شرايط بروز مشکل در اين محور، جاذبه زمین 
موجب حرکت ناخواس��ته می شود و متاس��فانه با توجه به اينکه ابزار روی محور  Z است منجر به بروز خسارت و 

جراحت می گردد

بیشترين آمار بروز حوادث مربوط به افراديست که غرور حرفه ای دارند.  -۵
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نحوه تعیین محورهای متعامد وچرخشی چگونه است؟  -۱
کدام نقطه صفر توسط سازنده تعريف می شود؟  -۲

رفرنس کردن دستگاه در چه مواقعی ضرورت دارد؟  -۳
چند دستگاه CNC را نام برده وکاربرد هرکدام را توضیح دهید؟  -4

فن آوری NC  را توضیح دهید.  -۵
اجزای اصلی ماشین های CNC را نام برده و شرح دهید؟  -6
روش های ورود اطلاعات به ماشین CNC را شرح دهید؟  -7

نقاط صفر ماشین، قطعه کار و ابزار را تعريف نمايید؟  -8

آزمونپایانی



    واحد کار

ششم
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اهدافرفتاری:

پسازآموزشاینواحدکارازفراگیرانتظارمیرودکهبتواند:

۱. مراحل ماشین کاری يک قطعه را ترسیم نمايد.

۲. اختلاف سطوح را با استفاده از نمای قطعه مشخص کند.

۳. ابزار مناسب جهت ماشین کاری را انتخاب نمايد.

4. خطوط  با مسیر ماشین کاری را در هر مرحله ترسیم نمايد.

۵. جبران شعاع ابزار در ترسیم مراحل ماشین کاری را اعمال نمايد.

6. حرکت ابزار بین سطوح مختلف را تشخیص داده و اعمال نمايد.

هدفکلی:تواناییتعیینمراحلکاروانتخابابزارمناسبجهتانجامکار

پیشآزمون:)20دقیقه(

۱- چگونه می توان مختصات يک نقشه را جابجا کرد؟

۲- بهترين نقطه صفر قطعه کار چه مکانی می تواند باشد؟

۳- يک قطعه کار را در چند مرحله کلی ماشین کاری می نمايند؟

4- بهترين دستور برای رسم خطوط ماشین کاری چه دستوری می باشد؟

۵- جبران شعاع ابزار به چه طريق اعمال می شود؟
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مراحلماشینکاری
قبل از نوشتن برنامه يک قطعه لازم است مراحل ماشین کاری آن تهیه شده و به وسیله نرم افزار رسم گردد  برای 
اين منظور در نرم افزار CAD هر مرحله را به صورت جداگانه ترس��یم کرده و س��طوح ماش��ین کاری را با هاشور 

مشخص می نمايیم.

با توجه به شکل ساده زير مشخص است که سطح طوسی رنگ بايستی از بلوک خام اولیه به عمق ۱0 میلی متر 
ماشین کاری شود.

در اين تصوير مشخص است که اگر مرکز محور مختصات را وسط قطعه کار در نظر بگیريم سطح بالای قطعه کار )روی 
 قطعه کار ( دارای Z=0 می باشد و  ابزار بايستی بر روی اين سطح مماس شود و مقدار Z آن بر روی دستگاه صفر شود.

-مرحله بعدی انتخاب ابزار مناس��ب برای ماش��ین کاری اس��ت، به طور اصولی يک قطعه کار در دو مرحله کلی 
ماشین کاری می شود.

۱-خشن کاری

۲-پرداخت

که ممکن است هرکدام از اين مراحل در چند مرحله ديگر انجام شود بعنوان مثال خشن کاری يک قطعه کار در 
سه مرحله و با سه ابزار با قطرهای متفاوت انجام پذيرد. و يا مرحله پرداخت در ۲ مرحله پیش پرداخت)به خاطر 

امکان پس زدگی ابزار( پرداخت انجام شود.

در مرحله خشن کاری قطعه کار به سايز نهايی نمی رسد و معمولا مقداری از ديوار و کف برای مراحل بعدی باقی 
می ماند اين مقدار با توجه به موارد زير تعیین می شود.
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۱- جنس قطعه کار :هر چه فلز نرم تر باشد مقدار ماده باقی مانده بیش تر است.

۲- شکل قطعه کار : مراحل پیش پرداخت و پرداخت شکل های پیچیده دارای شیب و منحنی ،بیشتر می باشد.

۳- دقت دستگاه و جنس ابزار.

4- تجربه برنامه نويس.

Stepoverمقدارجابجاییابزار-

مقدار جابجايی ابزار برای ماشین کاری يک قطعه کار بستگی به نوع ابزار دارد و بدين معنی است که ابزار بعد از 
طی يک مسیر مستقیم ماشین کاری چه مقدار جابجا شود.

مقدار جابجايی بستگی به نوع ابزار دارد که بشرح آن می پردازيم.

:Endmill)1-ابزارهایسرتخت)انگشتی

هنگام اس��تفاده از اين ابزارها،کل قطر ابزار با کار  درگیر می باش��د و مقدار حداکثر براده برداری برابر با قطر ابزار 
است بنابراين برای ماشین کاری مسیرهای بعدی لازم است ابزار به اندازه قطر جابجا شود.

فرض شود مسیر ماشین کاری يک قطعه به صورت زير است ابزار پس از طی مسیر  A لازم است مقداری جابجا 
شود که حداکثر اين جابجايی برابر قطر ابزار می باشد.
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 CAM در اين حالت ممکن است جای ابزار به صورت خطی بر روی قطعه کار باقی بماند معمولا در نرم افزارهای
و بطور کلی برای بدس��ت آوردن کیفیت س��طح بهتر اس��ت مقدار جابجايی را يک میلی متر از قطر ابزار کمتر در 

نظر می گیرند

Stepover=D-1

نکته: مقدار Stepover در خشن کاری و پرداخت تفاوتی ندارد فقط اين مقدار به نوع ابزار 
و قطر ابزار بستگی دارد

)Tip Radius(2-ابزارهایسرتختشعاعدار

اين ابزارها همانند شکل دارای کف تخت و گوشه های R دار می باشد و نوع الماسه خور آن نیز مورداستفاده قرار 
می گیرد که شعاع گوشه ها با توجه به شعاع الماسه مشخص می شود.
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همانطور که در ش��کل مش��خص است مقدار درگیری ابزار، کل قطر ابزار نمی باشد و فقط قسمت صاف آن درگیر 
می باشد که اين قسمت برابر است با:

Stepover=D-2R

که R مقدار شعاع لبه ابزار می باشد در شکل بالا مقدار Stepover برابر است با :

D-2R=30-2(0/6(=28/8

که برای سهولت برنامه نويسی اين مقدار را کمتر يعنی Steporer=28 در نظر می گیريم.
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ballnose3-ابزارهایسرگرد

س��ر اين ابزار ها گرد می باش��د و معمولا برای پرداخت س��طوح منحنی شکل و شیب دار استفاده می شود . مقدار 
جابجايی ابزار بس��تگی به کیفیت س��طح مورد نظر دارد و هر چه مقدار Stepover کمتر باشد کیفیت سطح در 

عملیات پرداخت )Finishing( بالاتر خواهد بود.

مسیر حرکت ابزار
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)Stepdown(مقدارباردهی-

مقدار بار دهی ابزار بستگی به موارد زير دارد:

۱- مرحله ماشین کاری )خشن کاری،پیش پرداخت،پرداخت(

۲- جنس و فرم قطعه کار

۳- جنس و فرم ابزار

البته لازم به ذکر است تجربه برنامه نويس و ماشین کار در تعیین مقدار بار تاثیر بسزايی دارد.

Toolpathتعیینمسیرماشینکاری-

بطور کلی مسیر ماشین کاری به دو روش زير تعیین می شود.

1-روشRaster: در اين روش معمولا ابزار حرکت مس��تقیم دارد و به صورت رفت و برگش��تی ماشین کاری را 
انجام می دهد. در شکل زير می خواهیم کل سطح قطعه کار را ماشین کاری نمايیم.

۱

۲

۳4
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در اين روش

۱- حرکت ابزار به صورت منظم تری انجام می شود.

۲- براده برداری به صورت موافق و مخالف انجام می شود.

۳- مقدار جابجايی ابزار طبق Stepover تعیین می شود.

4- حرکت ابزار تابع مدل قطعه کار نمی باشد.

2-روشOffset: در اين روش معمولا حرکت ابزار از شکل قطعه کار و پروفیل تبعیت می کند.

در ش��کل زير جهت حرکت ابزار با فلش مش��خص ش��ده است و مس��یر ابزار Toolpath ،رنگ مشکی مشخص 
می شود و مقدار جابجايی ابزار Stepover برابر است با قطر ابزار نهايی:

Steporer=D-1

در شکل زير می خواهیم کل سطح قطعه کار ماشین کاری نمايیم.

در اين روش :

۱- حرکت ابزار تابعی از شکل قطعه کار است و معمولا حرکت منظمی ندارد.

۲- زمان ماشین کاری در اين روش نسبت به روش Raster کمتر است.

۳

۲4

۹

0۱

8

۲۱

۱۱ 76

۱۵
Tool ابزار
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۳- حرکات اضافی ابزار نسبت به روش Raster بیش تر است.

4- مقدار Stepover  با توجه به جبران شعاع طبق محاسبات قبلی انجام می شود.

                    توجه:در اين روش تعیین مسیر حرکت ابزار)که در شکل باشماره مشخص شده(  بعهده برنامه 
نويس است که با توجه به شکل قطعه کار و نوع ماشین کاری)موافق ،مخالف يا ترکیبی( تعیین می گردد.

دستورکار1:

مطلوبست تعیین مراحل کاری و برنامه نويسی شکل زير

ابعاد بلوک خام   ۱00×۱00 وارتفاع ۲۵ میلی متر می باشد.

در اين ترس��یم بايستی س��طح قرمز رنگ به عمق ۱0 میلی متر ماشین کاری ش��ود برای اين قطعه مراحل زير را 
انتخاب می نمايیم. موارد زير را تعیین می نمائیم.

۱-ابزار انگشتی )Endmill( قطر ۱0

Raster ۲-روش

Stepover=9 ۳-مقدار

Stepdown=0.5 4-مقدار

نقطه شروع

از سطح بلوک خام
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مس��یر حرکت ابزار را در نرم افزار CAD به وس��یله دس��تور Offset می توان ترس��یم کرد و با قرار دادن محور 
مختصات  در مرکز قطعه مختصات ابتدا و انتهای خطوط را بدست آورده و برنامه آن را می نويسیم.

N10   G0   X-50   Y-50   Z10                                     .ابتدا ابزار به بالای نقطه  شروع می رود -

      N20   G1   Z-0/5   F100    .وارد قطعه کار می شود Stepdown سپس به اندازه بار مورد نیاز -

                      

  N10   G1   X50   Y-50 .مختصات نقاط انتهای قطعه کار را داده و برنامه خط ۱ را می نويسیم-

.به همین ترتیب برنامه خطوط ۲ و ۳ و ... تا انتها را می نويسیم                       

.  

.  

.  
- در انتها ابزار از قطعه کار خارج شده و مجدد به نقطه شروع می رود.   

N200    Z10
N210  G0   X-50   Y-50
N220   Z-1      



۱۳6

- و به عمق ماشین کاری سطح دوم می رود.

به همین ترتیب ماشین کاری تا انتهای کار و اتمام قطعه انجام می شود.

   نکته:

تعیین مسیر و روش ماشین کاری  و  انتخاب ابزار به عهده برنامه نويس می باشد و لازم است به نکات زير توجه نمايد.

۱-زمان ماشین کاری قطعه به حداقل برسد.

۲- مقدار حرکات اضافی ابزار حذف شود.

۳- جهت کاهش زمان ماشین کاری، از بزرگترين ابزار موجود ممکن استفاده شود.

4- برنامه نويس با توجه به شکل  می تواند برنامه را به صورت مطلق يا نسبی بنويسد.

دستورکار2:

برنامه ماشین کاری شکل زير را بنويسید.

برای نوشتن برنامه  ماشین کاری مراحل زير را بايستی مشخص نمايیم.

۱- تعیین بلوک ابعاد اولیه قطعه کار: ابعاد قطعه خام اولیه يک بلوک مس��تطیلی ش��کل بهاندازه ۱۵×۱00×۱00  
می باشد.

۲- انتخاب ابزار مناسب جهت ماشین کاری: ابزار Endmill به قطر ۱0
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۳- تعیین مراحل ماش��ین کاری به کمک نرم افزارCAD الف ( ماش��ین کاری پیرامون قطعه کار ب( ماشین کاری 
حفره میانی 

4- تعیی��ن مق��دار بار)Stepdown( و مقدار جابجايی ابزار )Stepover( : که با توجه به جنس قطعه کار و ابزار 
تعیین می گردد.

 offset يا raster ۵- تعیین ترسیم مسیر حرکت ابزار : روش

6- پیدا کردن مختصات ماشینکاری:

7- نوشتن برنامه 

بعد از تعیین مراحل ۱ و ۲ لازم است مراحل ماشین کاری با توجه به نرم افزار موجود طراحی و ترسیم شود

۱- ترس��یم مرحله اول ماش��ین کاری : اگر محور مختصات را روی کار ودر مرکز قطعه کار در نظر بگیريم عمق 
ماشین کاری ناحیه رنگی ۱0 میلی متر می باشد.
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 ۲- ترسیم سطح دوم ماشین کاری 

تعیینمسیرحرکتابزارToolpathsمرحلهاولبهدوروشزیر

Rasterتعیینمرحلهاولماشینکاریروش

با توجه به قطر ابزار تعیین شده مسیر حرکت ابزار را در نرم افزار AutoCAD به کمک دستورات ترسیمی مثل 
Offset ترسیم می نمايیم . که بايستی توجه داشته باشیم .

Go ابتدا ابزار بالای نقطه شروع قرار گیرد با حرکت -

Go با حرکت ) Stepdown ابزار به عمق مورد نظر رفته ) مقدار بار در مرحله اول -

- بعد از ترسیم مسیر حرکت محور مختصات را با استفاده از Ucslcon به نقطه مورد نظر انتقال دهیم.

- مختصات نقاط انتهای مسیر ابزار را با استفاده از نرم افزار استخراج نمايیم 

- مسیر حرکت ابزار را از ابتدا تا انتها مشخص نمايیم 

- با استفاده  از کدهای حرکتی G۱ و Go و غیره برنامه ماشینکاری سطح اول را بنويسیم.
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- ابزار را به عمق بعدی با کد G۱ انتقال دهیم 

- مسیر حرکت ماشین کاری سطح دوم را بنويسیم

                        

               توجه:

بعد از ترسیم خطوط ماشین کاری بر روی قطعه وبا رنگی متفاوت محور ماشین کاری استخراج کرده و برنامه آنرا 
می نويسم لازم به ذکر است تعیین

- خطوط قرمز رنگ مسیر حرکت ابزار 

Go خطوط قرمز رنگ خط چین حرکت بدون براده برداری ابزار -

 همانطور که مشخص است منطقه ماشین کاری شده در دو مرحله انجام شده است.

شروع ماشین کاری



۱40

 ابزار
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Offset تعیین مرحله اول ماشین کاری به روش -

- مرحله اول ماشــین کاری را به روش دیگری نیز می تــوان انجام داد بدین ترتیب که ابزار بزرگ تری را انتخاب 
نماییم  مثلاً ابزار Endmill  فقط 15 میلی متر و مسیر ابزار را به صورت شکل زیر در نرم افزار CAD ترسیم 
نماییم ملاحظه می نمایید که دراین حالت برنامه ماشــین کاری کوتاه تر شده و زمان کمتری صرف ماشین کاری 

قطعه می شود.

                          نکته:

 برای تعیین مســیر ماشین کاری کافیست مربع داخلی شکل را به اندازه شعاع ابزار offset نماییم اگر کل سطح 
ماشین کاری پوشش داده نشود مجدد خطوط را به اندازه Steporer و Offset نماییم.

مسیر ماشین کاری
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۲- تعیینمرحلهدومماشینکاری

 R۵ همانطور که مش��خص کرديم ناحیه داخلی بايس��تی در مرحله دوم ماشین کاری شود با توجه شعاع گوشه ها
از ابزار قطر ۱0 استفاده می نمايیم تا علاوه بر کوتاه شدن مسیر ماشین کاری گوشه های قطعه کار با حرکت ابزار 

ايجاد گردد.
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دراين مرحله ابزار مس��یر دايروی و چهارگوش را طی کرده تا حفره در پاس اول خالی ش��ود سپس بهمین ترتیب 
به عمق بعدی رفته و عملیات ماشین کاری را تکمیل می  نمايد.

لازم ب��ه ذکر اس��ت در اين برنامه مقدار ب��ارStepdown را ۵ میلی متر در نظر گرفته اي��م که اين مقدار جهت 
ماشین کاری عملی زياد می باشد و بايستی مقدار Stepdown با توجه به جنس قطعه کار جنس ابزار و توانايی 

ماشین کاری دستگاه تعیین گردد.

شکل کلی مسیر ماشین کاری به صورت زير است

دستورکار3

برنامه ماشین کاری شکل زير را بنويسید.
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۱- تعیین بلوک ابعاد اولیه قطعه کار: ابعاد قطعه خام اولیه يک بلوک مس��تطیلی ش��کل بهاندازه ۱۵×۱00×۱00  
می باشد.

۲- انتخاب ابزار مناسب جهت ماشین کاری: ابزار Endmiu به قطر ۱0

۳- تعیین مراحل ماش��ین کاری به کمک نرم افزارCAD الف ( ماش��ین کاری پیرامون قطعه کار ب( ماشین کاری 
حفره میانی 

4- تعیی��ن مق��دار بار)Stepdown( و مقدار جابجايی ابزار )Stepover( : که با توجه به جنس قطعه کار و ابزار 
تعیین می گردد.

 Offset يا Raster ۵- تعیین ترسیم مسیر حرکت ابزار : روش

6- پیدا کردن مختصات ماشینکاری:

7- نوشتن برنامه 

CADتعیین مراحل ماشین کاری به کمک نرم افزار -

بعد از تعیین مراحل ۱ و ۲ لازم است مراحل ماشین کاری با توجه به نرم افزارهای موجود طراحی و ترسیم کنیم

۱- ترس��یم مرحله اول ماش��ین کاری: اگر محور مختصات را روی کار و در مرکز قطعه کار در نظر بگیريم عمق 
ماشین کاری ناحیه رنگی ۲0 میلی متر می باشد.



۱4۵

۲- ترسیم مرحله دوم ماشین کاری 

۳- مرحله سوم ماشین کاری 

4- مرحله چهارم ماشین کاری 



۱46

۵- مرحله آخر ماشین کاری 

تعیینمسیرحرکتابزار

۱- مرحله سوم ماشین کاری 

۲- مرحله چهارم ماشین کاری 

۳- مرحله آخر ماشین کاری 

مرحله اول ماشین کاری 



۱47

مرحله ب مرحله دوم ماشین کاری 

در اين مرحله کافیست با چند حرکت قدسی شکل قسمت مورد نظر را ماشین کاری نمايیم 

- مرحله سوم ماشین کاری 



۱48

- مرحله چهارم ماشین کاری 



۱4۹

مرحلهآخر

در اين مرحله کافیست با يک حرکت خطی چهارگوش حفره نمايی ماشین کاری شود.



۱۵0

۱- ش��کل های زير را در نرم افزارAuto CAD رسم کرده و بعد از ترسیم مراحل ومسیر ماشین کاری 
برنامه آنرا بنويسید.

آزمونپایانی



۱۵۱



۱۵۲



۱۵۳




